TestTrack
Simply Better Bug Tracking

Seapine
Software

User Manual

version 1.6 for Macintosh

Third Edition
Copyright

December 1997
© Copyright Seapine Software, Inc. 1997-1998. All rights reserved. No
part of this publication may be reproduced, transmitted, transcribed,
stored in a retrieval system, or translated into any language in any form
by any means without the written permission of Seapine Software, Inc.
Information in this document is subject to change without notice and
does not represent a commitment on the part of Seapine Software, Inc.
Unless otherwise noted, all names of companies, products, street
addresses, and persons contained herein are fictitious and are used only
to document the use of TestTrackTM.

Software
License Notice

Your license agreement with Seapine Software, Inc. which is included
with the product, specifies the permitted and prohibited uses of the
product. Any unauthorized duplication or use of TestTrackTM, in whole
or in part, in print, or in any other storage and retrieval system is
forbidden.

Licenses
and Trademarks

TestTrack and the Seapine logo are trademarks of Seapine Software, Inc.
Apple, Macintosh, Mac OS, System 7.5, Power Macintosh,
OpenTransport, Apple SuperDrive, and AppleShare are registered
trademarks of Apple Computer, Inc. Adobe Acrobat is a registered
trademark of Adobe Systems, Inc. RAM Doubler is a registered
trademark of Connectix Corporation.
APPLE COMPUTER, INC.

(“APPLE”) MAKES NO WARRANTIES, EXPRESSED OR IMPLIED,

INCLUDING WITHOUT LIMITATION THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE, REGARDING THE APPLE SOFTWARE. APPLE DOES NOT
WARRANT, GUARANTEE OR MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE
RESULTS OF THE USE OF THE APPLE SOFTWARE IN TERMS OF ITS CORRECTNESS, ACCURACY,
RELIABILITY, CURRENTNESS OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND
PERFORMANCE OF THE APPLE SOFTWARE IS ASSUMED BY YOU. THE EXCLUSION OF IMPLIED
WARRANTIES IS NOT PERMITTED BY SOME STATES. THE EXCLUSION MAY NOT APPLY TO YOU.

Seapine Software, Inc.
1066 Seapine Ct.
Maineville, Ohio 45039
513.683.6456
U-0110-1.600
Printed in the USA

Contents

About TestTrack

ix

On the TestTrack CD ROM...........................................x
About your TestTrack User Manual............................x
Things you should know before you start ............... xii
How to contact TestTrack support services............. xii
What you need to use TestTrack.............................. xiii

TestTrack User Manual

1

Getting Started

2

Learning the Basics

1

Installing TestTrack........................................................2
Personalizing your copy of TestTrack.........................3
Starting TestTrack ..........................................................6
Exiting TestTrack ...........................................................6

7

Opening a list window ..................................................8
Using a list window .....................................................10
Sorting by column.................................................11
Changing the sort order of a column .................12
Changing the width of a column ........................12
Changing the contents of a column ....................13
Adding a column ..................................................14
Deleting a column .................................................15
Selecting multiple items .......................................15
Using the command buttons ...............................16
Looking at the defect indicators..........................18
Using the Edit and View dialog boxes ......................19
Using the toolbar..........................................................20
Printing ..........................................................................22

iii

iv

3

Working with Project Files

4

Working with Defects

25

About project files ........................................................26
Creating a project file...................................................27
Configuring field values .............................................31
Adding a field value.............................................34
Changing a field value .........................................36
Deleting a field value............................................38
Setting a password.......................................................39
Changing or removing a password ...........................40
Setting Preferences.......................................................42
Configuring attachment settings................................46
Looking up project file information...........................48
Compacting a project file ............................................50
Logging in another user ..............................................51
Listing active users.......................................................52
Polling a project file .....................................................53
Importing a file.............................................................54
Creating an Import Template .....................................58
Loading an Import Template......................................59
Exporting a file .............................................................59
Creating an Export Template .....................................62
Loading an Export Template ......................................63
Backing up your work .................................................64
Creating a project template.........................................65
Making a single-user project file multi-user.............66
Recovering a damaged project file.............................67

69

About defects................................................................70
Understanding a defect’s life cycle ............................70
Taking a look at defect actions ...................................72
Deferred defect numbering.........................................75
Configuring deferred defect numbering............75
Using deferred defect numbering.......................76
Assigning defect numbers ...................................77
Communicating with others .......................................78
Filtering out unwanted defects ..................................79
Adding a defect ............................................................80
Adding multiple reports of a defect ..........................87
Duplicating a defect.....................................................88

TestTrack User Manual

Attaching a file to a defect ..........................................89
Extracting an attached file from a defect ..................90
Viewing an attached file..............................................92
Deleting an attached file from a defect .....................93
Merging defects............................................................93
Viewing a defect...........................................................95
Going to a specific defect ............................................96
Finding defects .............................................................97
Changing a defect ........................................................98
Deleting a defect.........................................................100
Deleting a report of a defect from a list
of multiples .................................................................100
Assigning a responsible person................................101
Estimating the time needed to fix a defect..............102
Fixing a defect.............................................................103
Verifying a defect .......................................................105
Re-opening a defect ...................................................107
Closing a defect ..........................................................108
Adding release notes a defect...................................110
Adding comments to a defect...................................111
Changing a defect action...........................................112
Deleting a defect action .............................................114
Renumbering a defect................................................115

TestTrack User Manual

5

Working with User Groups

6

Working with Users

117

About user groups and security...............................118
Adding a user group .................................................119
Adding users to a user group...................................123
Viewing a user group ................................................124
Changing a user group..............................................126
Deleting a user group ................................................127

129

About users .................................................................130
Adding a user .............................................................131
Viewing a user............................................................135
Changing a user..........................................................136
Deleting a user............................................................137
Making a customer a user .........................................138

v

7

Working with Customers

8

Working with Filters

9

Working with Test Configurations

10

vi

139

About customers ........................................................140
Adding a customer manually...................................141
Making a user to a customer.....................................144
Viewing a customer ...................................................145
Changing a customer.................................................147
Duplicating a customer .............................................148
Deleting a customer ...................................................148

149

About filters ................................................................150
Adding a filter ............................................................151
Using a filter ...............................................................156
Viewing a filter ...........................................................157
Changing a filter.........................................................159
Deleting a filter ...........................................................161

163

About test configurations..........................................164
Adding a test configuration......................................164
Viewing a test configuration.....................................165
Changing a test configuration ..................................167
Deleting a test configuration.....................................168

Working with Reports

169

About reports..............................................................170
Adding a detail report...............................................172
Adding a distribution report ....................................175
Adding a list report....................................................177
Adding a trend report ...............................................180
Viewing a report’s settings .......................................182
Changing a report ......................................................183
Deleting a report ........................................................184
Previewing a report ...................................................184
Printing a report .........................................................186
Generating release notes ...........................................186

TestTrack User Manual

11

Working with the Workbook

12

Working with Solo Bug

13

Working with E-mail Notifications

14

Working with E-mail Import

TestTrack User Manual

191

About the Workbook .................................................192
Understanding Workbook tasks .......................192
Looking at the task indicators ...........................193
Adding a To Do task..................................................194
Viewing a To Do task.................................................195
Changing a To Do task ..............................................197
Deleting a To Do task ................................................198

201

About Solo Bug...........................................................202
How do I distribute Solo Bug? ..........................202
What is a Solo Bug file? ......................................203
How do I import a Solo Bug file?......................203
Customizing the Solo Bug application ....................203
Loading Solo Bug files manually .............................207
Activating the Solo Bug file auto-load feature .......208
Loading Solo Bug files automatically ......................211
Customizing the Solo Bug user’s guide ..................212

213

About e-mail notifications.........................................214
Configuring e-mail notifications ..............................215
Setting Send Mail options ..................................215
Verifying user notification settings...................216
Configuring e-mail message templates...................218
Sending e-mail in the background...........................221
Sending e-mail manually ..........................................221
Sending mail to any user or customer..............221
Replying to a defect’s submitter........................223
Pausing e-mail notifications......................................225

227

About e-mail import ..................................................228
Configuring e-mail import........................................228

vii

A

viii

Appendix A Field Codes

231

About Field Codes .....................................................231
Field Codes .................................................................232
Field Code Notes........................................................234

TestTrack User Manual

TestTrack User Manual

ix

About TestTrack

Contents
Inside your TestTrack
package
About your TestTrack
User Manual
Things you should know
before you start
How to contact TestTrack
support services
What you need to use
TestTrack

About TestTrack

Welcome to TestTrack!

TestTrack is the premier bug tracking program
for Windows 95 and NT. TestTrack lets you take
control of your bug-tracking hassles.
Design a complex tracking structure, or simply
install the software and start tracking the
TestTrack way!

ix

On the TestTrack CD ROM
The TestTrack CD ROM contains:
• TestTrack 1.6 for Macintosh, Windows 95, and
Windows NT 4.0
• Solo Bug 1.1 for Macintosh, Windows 3.1, Windows 95, and
Windows NT 4.0
• Online Documentation and Help Files
Demos of TestTrack and other third-party products

About your TestTrack User Manual
This user manual provides step-by-step instructions for all
the tasks you perform when working with TestTrack and
consists of the following chapters:
• Chapter 1, “Getting Started,” shows you how to start and
quit TestTrack.
• Chapter 2, “Learning the Basics,” teaches you the basics. Be
sure to read this chapter as a jump-start to TestTrack and to
learn time-saving shortcuts.
• Chapter 3, “Working with Project Files,” explains how to
create a single-user or multi-user project file. It also explains
how to customize a project file, set preferences, and set a
password.
• Chapter 4, “Working with Defects,” explains how to add
defects (bugs, enhancements, change requests, or any other
product-related issue you wish to remember and resolve) to
the project file.
• Chapter 5, “Working with User Groups,” explains how to
add user groups to the project file. User groups allow you to
add command-level security to multi-user project files.
• Chapter 6, “Working with Users,” explains how to add
TestTrack users to the project file.

x
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• Chapter 7, “Working with Customers,” explains how to add
customers to the project file.
• Chapter 8, “Working with Filters,” explains how to add
filters to the project file. A filter is a powerful search and
retrieval tool. You use filters to list only those defects you
want to see (or report on).
• Chapter 9, “Working with Test Configurations,” explains
how to add test configurations to the project file. A test
configuration is the configuration on a specific computer
used for testing.
• Chapter 10, “Working with Reports,” explains how to create
and print reports.
• Chapter 11, “Working with the Workbook,” explains how to
add, change, view, and delete To Do tasks in the Workbook.
Use the Workbook to track your assignments and non-defect
development tasks.
• Chapter 12, “Working with Solo Bug,” explains how to set
up Solo Bug for your customers and how to import Solo Bug
defect reports they have sent you.
• Chapter 13, “Working with E-mail Notifications,” explains
how to set up e-mail notifications.
• Chapter 14, “Working with E-mail Import,” explains how to
set up TestTrack to import bug reports from an e-mail
account.
• Appendix A, “Field Codes,” details the fields codes used to
create personalized e-mail notification templates.

About TestTrack
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Things you should know before you start
Make sure you understand the following basic concepts
before you use TestTrack:
About your
computer and
printer

This guide assumes your Macintosh and printer are set
up and ready to use. It also assumes you know how to
perform the basic skills needed to use them. If you need
more information on basic Macintosh features, refer to
the user’s guide that came with your computer.

About your
defect tracking
procedures

Before you use TestTrack, you should think about how
you want TestTrack to work for you. Do you want to set
up a complex tracking structure to be used by many
people and many departments? Or do you simply want
to install the program and start tracking? —Or do you
want to mix and match, using different scenarios for
different project files?
TestTrack works any way you want it to! Chapter 3,
“Working with Project Files,” helps you decide how
TestTrack can work best for you.

How to contact TestTrack support services
We offer free TestTrack technical support Monday through
Friday between 9 AM and 5 PM eastern-standard time.
Telephone Support

513-683-6456

Fax Support

513-683-1781

E-mail Support
Worldwide Web
Address

Note

xii

support@seapine.com
http://www.seapine.com

Check our Worldwide Web Site for the latest TestTrack
and Solo Bug news, answers to frequently asked questions,
and updates on TestTrack and Solo Bug.
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What you need to use TestTrack
You need the following hardware and software to use
TestTrack for Macintosh:
• Macintosh 68020-68040 or Power Macintosh
• 4 MB of memory (2 MB free)
• System 7.0 or higher
• A CD-ROM drive (required for installation only)

About TestTrack

xiii

xiv
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Getting Started

Contents

1-2-3 Start Tracking!

Installing TestTrack
Personalizing your copy
of TestTrack
Starting TestTrack
Exiting TestTrack

In minutes, you can install TestTrack and start
tracking. Why wait any longer?

Chapter 1. Getting Started

This chapter explains how to install, personalize,
start, and quit TestTrack.

1

Installing TestTrack
1.

Insert the TestTrack disk labeled “Install Me First” in the
floppy drive.
The disk opens on the desktop. You can see the Install
TestTrack icon.

2.

Double-click the Install TestTrack icon.
The Install TestTrack splash screen appears.

3.

Choose Continue.
The Install TestTrack Welcome window appears.

Note

2

Click Read Me to review important information about
TestTrack. From the Read Me window, choose Print to
print the Read Me file. Choose Save to save the file to
another location.
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4.

Choose Install.
A progress bar appears showing the installation progress.
When the installation is finished, a message tells you the
installation was successful.

Note

5.

The Install TestTrack program installs TestTrack on the
start-up volume. If you wish to install TestTrack on
another volume, choose Select Folder and pick a new
location.
Choose Quit.
You are ready to start TestTrack for the first time!

Note

The TestTrack User Manual is stored in Adobe Acrobat
format. If you do not already have a copy of Adobe
Acrobat 2.1 or newer on your hard drive, run the Adobe
Acrobat Installer (it’s on the disk labeled Acrobat Disk 1;
double-click the Install Acrobat icon).

Personalizing your copy of TestTrack
To start TestTrack for the first time and personalize your
copy:
1.

Chapter 1. Getting Started

Double-click the TestTrack icon.

3

The TestTrack Registration window appears. The Name field
defaults to the name of your computer. You may enter a new
name if you wish.

2.

Enter a name in the Organization field.
Commonly, users enter their company’s name in this field,
but you may enter a department name or anything else.

3.

Enter your serial number.
You can find your serial number on the inside front cover of
the TestTrack user manual. Enter the number exactly as you
see it—this is a case-sensitive field.

Note

4

If you’ve lost your serial number and you’re a registered
user, contact us. We can tell you your serial number over
the phone or via e-mail. If you purchased TestTrack
directly from Seapine Software, you are registered
automatically.
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4.

Choose OK.
The Open File dialog box appears.

Ä

Where to go next...
At this time you can:
• Choose New to open a project file and start tracking.
See Chapter 3, “Working with Project Files,” to
continue.
• Choose Cancel to close the Open File dialog box.

Chapter 1. Getting Started
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Starting TestTrack
Note

The first time you start TestTrack you are prompted to
enter your serial number. See “Personalizing your copy of
TestTrack,” previous, if you have not done so already.
To start TestTrack:

1.

Double-click the TestTrack icon.

TestTrack remembers the last project file you had open and
opens it automatically when you start the program.

Note

If you prefer, you can set TestTrack to default to the Open
File dialog box instead of automatically opening the lastused file. See “Setting preferences” in Chapter 3, “Working
with Project Files.”

Single-user
project file

If you open a single-user project file, TestTrack opens the
file without prompting you for anything, unless it is
password protected. In which case you enter the password
and click OK.

Multi-user
project file

If you open a multi-user project file, TestTrack prompts
you for a user name and password. Enter the information
and click OK.

Exiting TestTrack
1.

Choose Quit from the File menu.
TestTrack closes.

6
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Learning the Basics

Contents

Take a tour!

Opening a list window
Using a list window
Using the Edit and View
dialog boxes
Using the toolbar
Finding defects
Printing

TestTrack is easy to use, but it’s even easier when
you know the basics and the shortcuts.

Chapter 2. Learning the Basics

This chapter takes you on a tour of TestTrack.
Use it to start you on your way.

7

The first time you start TestTrack, a blank Defects list
window appears. The following graphic points out each part
of TestTrack:
Toolbar
Message area
List window
command buttons

Column heading

List window
List total

Opening a list window
TestTrack tracks defects, test configurations, users, and user
groups. It also lets you use filters and reports to manage and
analyze your data. Each item you can work with appears in
its own list window.

8
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The toolbar contains command buttons to open each list
window—and they are just a click away!
Opens the Defects list window
Opens the Customers list window
Opens the Test Configurations list window
Opens the Users list window
Opens the User Groups list window
Opens the Filters list window
Opens the Reports list window
Opens the Workbook list window
If you prefer to use the menu, the commands are there too.
Simply select the item’s name from the Window menu.

Chapter 2. Learning the Basics
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Using a list window
All seven of TestTrack’s list windows function the same way.
You can organize the data in the window any way you wish.
You can do the following in a list window:
• Sort by column (primary and secondary sorts)
• Sort in ascending or descending order
• Change the width of a column
• Change the contents of a column
• Add or delete a column
• Select multiple items for viewing, editing, deleting, and
printing
• Use shortcut command buttons
• Identify new defects, closed defects, and defects assigned to
you—at a glance

10
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Sorting by column
You may sort by any column at any time, and you may
perform primary and secondary sorts:
Primary sort

To select a new column to sort by, click on the column
heading. A single tick mark appears to the right of the
column heading. For example, the following list is sorted
by Status:

This list is sorted
by Status.

Secondary sort

To select a secondary column to sort by, shift-click on the
column heading Two tick marks appear to the right of the
column heading (the primary column heading remains the
same). For example, the following list is sorted first by
Status and then by Priority.

The primary sort
is by Status.

The secondary
sort is by Priority.

Chapter 2. Learning the Basics
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Changing the sort order of a column
With the click of a button, you can change the order in which
a column is sorted from ascending to descending, or vice
versa.
To change the sort order:
1

Click on the column heading you want to work with.

2

Click the Sort Order icon.
The Sort Order icon is located on the far right side of the list
window just above the scroll bar. The icon toggles between
ascending and descending order.

Click the Sort
Order icon to
toggle between
ascending and
descending order.

Changing the width of a column
To make a column wider or narrower:
1

Move the cursor to the divide bar located between the
column headings.
The cursor changes to a Resize cursor.

Position the
Resize cursor
between the
column
headings.

2

Click and drag the divide bar to a new position.
The action changes the width of the column to the left of the
divide bar.

12
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Changing the contents of a column
At any time you can change what is listed in a column by
selecting a new field for the column heading. To select a new
field:
1

Click on the column heading you want to change and hold
down the mouse button until a pop-up menu appears.
The pop-up menu lists all the available fields.

2

Release the mouse button when you’ve highlighted the
desired field.
The column heading changes to the new field and the
contents of the column changes to match it.

Chapter 2. Learning the Basics
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Adding a column
To add a column:
1

Click on the column heading you want to add a column
next to (inserts to left), and hold down the mouse button
until a pop-up menu appears.
The pop-up menu lists all the available fields, plus two
additional commands: Insert Column and Remove Column.

2

Release the mouse button when you’ve highlighted Insert
Column.
A blank column is added to the left. You can now select a
field for its contents. See “Changing the contents of a
column,” previous, if you need to review.

Select a
column
heading from
the pop-up
menu.

14
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Deleting a column
To delete a column:
1

Click on the column heading you want to delete, and hold
down the mouse button until the pop-up menu appears.
The pop-up menu lists all the available fields, plus two
additional commands: Insert Column and Remove Column.

2

Release the mouse button when you’ve highlighted
Remove Column.
The column is removed.

Selecting multiple items
You can select multiple items to view, edit, delete, and print:
Range

Chapter 2. Learning the Basics

To select a range of items, click the first item in the range,
then shift-click the last item.

15

Items not in a
range

To select multiple items not in a range, command-click
each item.

Using the command buttons
Each of the six TestTrack list windows has the following four
command buttons:
Opens the selected item’s View dialog box.
Opens the selected item’s Add dialog box.
Opens the selected item’s Edit dialog box.
Deletes the selected item from the list window.

16
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The command
buttons are
located at the
top of every
list window.

Tip

Since the Edit
command button
is bold....

You can set double-clicking preferences for the View and
Edit command buttons. For example, if the Edit button is
bold, you can double-click an item to select it and open the
Edit dialog box at the same time. See “Setting preferences”
in Chapter 3, “Working with Project Files,” for details.

... the Edit dialog box
appears when you
double-click an item.

Chapter 2. Learning the Basics

17

Looking at the defect indicators
Defect indicators appear in the first column of the Defects
list window. They point out new defects, closed defects, and
defects assigned to you. The following shows a sample of
each indicator:
The New Defect indicator points out any defects added to
the project file since you last logged in.
The Defect Changed indicator points out any defects that
have changed since you last logged in.
The Closed Defect indicator points out any closed defects.
The Assigned Defect indicator points out any defects that
have been assigned to you (the current user).

This defect is
new since you
last logged in.
This defect
changed since you
last logged in.
This defect is
assigned to you.
This defect is
closed.

Note

18

Notice that the closed defect is grayed out. You can set this
preference in the Preference dialog box. See “Setting
preferences” in Chapter 3, “Working with Project Files.”
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Using the Edit and View dialog boxes
When you open the View and Edit dialog boxes, next and
previous arrows appear at the bottom of the dialog boxes.
Click the arrows to page through the items.

Click the arrows
to page through
the selected
items.

If you open the Edit dialog box to edit an item, and it is
already being edited by another user, a Read-only icon
appears beside the Cancel button. You can’t edit an item
when the Read-only icon is present.

You can’t edit an
item when the
Read-only icon is
present.

Chapter 2. Learning the Basics
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If you click the Read-only icon, a message box appears
listing the name of the user currently editing the item.

When the user finishes editing the item, the Read-only icon
disappears, and the dialog box updates with any changes the
user made. You are now free to edit the item.
Note

When a record is read only, TestTrack checks the project
file every 10 seconds for changes no matter what interval
you set in the Preferences dialog box. This way the item
frees up as soon as the other user is finished with it.

Using the toolbar
You already know that you can use the command buttons on
the toolbar to open TestTrack’s list windows, but you can use
the toolbar for more. The toolbar contains the following
additional command buttons:
Opens an existing project file. TestTrack automatically
closes the current project file before it opens a new one.
Opens the Print Options dialog box. See “Printing,” later in
this chapter, to learn your printing options.
Opens the Find Defects dialog box. See “Finding defects,”
in Chapter 4, “Working with Defects”, to learn about this
quick-find option.

20
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The tool bar also contains a message area. TestTrack posts
messages here that don’t require your feedback. The
following lists a few of the messages you may see:
• When you place the cursor over a command button in the
toolbar, a short description of the command appears.

• When you open a multi-user project file, the message area
lists how many defects are assigned to you and how many
have been added since you last logged in.

Note

The toolbar is anchored to its present location, but you can
unanchor it and move it to another part of the screen:
choose Unanchor Toolbar from the Windows menu.
Choose Anchor Toolbar to re-anchor the toolbar.
If you want to remove the toolbar, choose Hide Toolbar
from the Windows menu. To reinstate the Toolbar, choose
Show Toolbar from the Windows menu.

Chapter 2. Learning the Basics

21

Printing
To print:
1

Choose Print from the File menu, or click the Print button
located on the toolbar.
The Print Options dialog box appears.

2

Make your selections.
Select one of the following radio buttons:

Print as list

Print as detail

Note
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Prints the items in a list as you see them. The column
widths are adjusted automatically based on the length of
the longest field value. Select the check box if you want
grid lines to print.
Prints the details for each item. Select the check box if you
want each item printed on its own page.

If you do not want to print every item in the list, go back to
the list window and select the items you want to print;
then return to the Print Options dialog box and select the
Only Print Selected Items check box.

TestTrack User Manual

3

Choose Preview or Print.
The following describes your choices:

Preview

The Print Preview dialog box appears. Page through the
window to check your selections. Choose Page Setup if
you want to change the layout settings. When you’re
satisfied with the preview, click Print. The Printer dialog
box appears. Choose your settings and click Print again.

Print

The Printer dialog box appears. Choose your settings and
click Print.

Chapter 2. Learning the Basics
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Working with Project Files

Contents

Lay the foundation!

About project files
Creating a project file
Configuring field values
in a project file
Setting a password
Changing or removing
a password
Setting preferences
Configuring attachments
Viewing project information
Compacting a project file
Logging in another user
Listing active users
Polling a project file
Importing a file
Exporting a file
Backing up your work
Creating a project template
Toggling multi-/single-user
Recovering a project file

Sound hard? It’s not—simply give the project file
a name and choose whether it is a multi-user or
single-user file.
If you wish, you can customize the project file by
configuring the field values to match your
organization’s nomenclature. However,
TestTrack comes fully operational with generic
default values, so you can skip this task and start
tracking!
This chapter explains how to create project files.
You also learn how to set passwords to protect
them. The chapter starts with an explanation of
multi-user and single-user.

Chapter 3. Working with Project Files
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About project files
A project file holds all the data you keep track of in
TestTrack.

The information in a project file is specific to that file. It is
not shared among other project files. When you create a
project file, you can make it a single-user project file or a
multi-user project file:

26

Single-user
project file

Only one person can access a single-user project file at a
time. A single-user project file is ideal for consultants,
individuals tracking bugs on their own projects, and small
teams where security is not an issue. On a single-user
project file, you can set a password to protect the file.

Multi-user
project file

Unlimited numbers of users can access a multi-user project
file over a network. A multi-user project file is ideal for
large groups of users in organized testing efforts. Multiuser project files let you take advantage of command-level
security, notifications, and shared filters and reports

Note

TestTrack uses file sharing to implement multi-user access.
An AppleShare-compatible file server, Windows NT
Server, or Macintosh Personal File Sharing all work fine in
multi-user environments.
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Creating a project file
To create a project file:
1

Choose New Project from the File menu.
The New File dialog box appears.

Note

2

If you chose New from the Open File dialog box when you
started TestTrack, you already performed this step. Move
on to step 2.
Type a name for the project file.
The name can be up to 32 characters long.
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3

Choose the type of project file.
Choose Multi-user if you plan to use TestTrack on a network
and share your data with others; otherwise, choose Singleuser.

Be sure to select
the type of project
file.

Note

4

You can’t change a single-user project file to a multi-user
project file, or vise-versa, after you create the project file.
Make sure you choose the correct setting before you begin
adding data.
Choose Save.
If you created a multi-user project file, the Welcome to
TestTrack dialog box appears suggesting you set a password
for the user name “Admin.” Choose OK.
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The Project Information dialog box appears. The cursor is on
the Project Name field. You may change the name, or move
to the Description field.

&

If you want to know more...
When you create a multi-user project file, TestTrack
automatically assigns you the user name “admin” and
places you in user group “administration.”
The user group “administration” has complete security
clearance. To protect this security level from
unauthorized users, set a password. Do it now by
selecting Set Password from the File menu. See “Setting
a password,” later in this chapter, if you need further
instructions.
As project administrator, you are responsible for
performing tasks such as adding users, setting security
levels, and maintaining the database. You learn more
about this in Chapter 5, “Working with User Groups.”

5

Type a description.
The description may be up to 255 characters. You should
provide more information about the project, such as the
name of the QA leader or project leader.
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6

Choose OK.
The Defects list window appears.

Ä

Where to go next...
At this time you can:
• Customize the project file’s field values to match
your organization’s terms. See “Configuring a project
file,” next, for instructions. TestTrack comes with
generic field values, so if you prefer, you can skip
this task and move on to Chapter 4, “Working with
Defects.”
• Add user groups and users to the project file. If
you’re using a multi-user project file, do this before
you work with defects. See Chapter 5, “Working with
User Groups,” for instructions.
• Define e-mail notification settings. Do this before you
begin working with defects to ensure all users receive
notifications when the first defects are added. See
Chapter 13, “Working with E-mail Notifications,” for
instructions.
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Configuring field values
Configuring field values in TestTrack is quick and easy. The
changes you make affect only the project file you’re working
on. They do not affect other project files.
You can configure values for the following fields:
Defect Types

Defect
Resolutions

Defect type values explain the kind of defect you’ve found.
TestTrack comes with the following default values:

Defect resolution values explain how the bug was fixed.
TestTrack comes with the following default resolutions:
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Defect Priorities

Defect Severity

32

Defect priority values rank when to fix one bug relative to
another. TestTrack comes with the following default
priorities:

Defect severity values rank a bugs importance to the
customer. For example, a data corruption bug is more
severe than a functionality bug with a workaround.
TestTrack comes with the following default severities:
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Product Names

Components

Product name values describe modules or products tracked
in a project. For example, a product named WysiApp may
consist of WysiWrite, WysiChart, WysiCalc, and
WysiDraw. Simply add these names to track bugs by
module! Since these field values are specific to your project,
TestTrack does not come with default product name
values. However, TestTrack adds the name of your project
file to the list to get you started.

Component values describe parts common to products or
projects. For example, you may use a charting module in
more than one of your products. Since these field values
are specific to your project, TestTrack does not come with
default component values.
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Reproducible
Levels

Reproducible Level values describe whether a user could
reproduce a problem.

Adding a field value
1

Note

Choose the item you want to customize from Configure on
the Activities menu.
In this example, we work with Defect Types. However,
whether you choose Defect Resolutions, Defect Priorities,
or Product Names, you follow the same instructions.
The Set Up Defect Types dialog box appears.
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2

Click Add.
The Add Defect Type dialog box appears.

3

Type a name for the new defect type.
You are limited to 32 characters.

4

Choose OK.
The Add Defect Type dialog box closes and you return to the
Set Up Defect Type dialog box. The new name appears at the
bottom of the list.

Note

To move the name to a new position in the list: select the
name and click the Up button. If you move it too far, click
the Down button.

Use these buttons
to reposition the
selected field value.
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5

Choose Close.
The dialog box closes.

Changing a field value
1

Note

Choose the item you want to customize from Configure on
the Activities menu.
In this example, we work with Defect Types. However,
whether you choose Defect Resolutions, Defect Priorities,
or Product Names, you follow the same instructions.
The Set Up Defect Types dialog box appears.

2

36

Select the name you want to change.
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3

Click Edit.
The Edit Defect Type dialog box appears.

4

Change the name.

5

Choose OK.
The Edit Defect Type dialog box closes and you return to the
Set Up Defect Type dialog box. The new name appears in the
same location.

Note

To move the name to a new position in the list: select the
name and click the Up or Down button.

Use these buttons
to reposition the
selected field value.

6

Choose Close.
The dialog box closes.
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Deleting a field value
1

Note

Choose the item you want to customize from Configure on
the Activities menu.
In this example, we work with Defect Types. However,
whether you choose Defect Resolutions, Defect Priorities,
or Product Names, you follow the same instructions.
The Set Up Defect Types dialog box appears.

2

Select the name you want to delete.
The name is highlighted.

3

Click Delete.
The Delete Confirmation dialog box appears.
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4

Choose OK.
The name is removed from the list box.

Note

5

If the field value is used in any defect, TestTrack prompts
you to reassign it to one of the existing names.
Choose Close.
The dialog box closes.

Setting a password
In a single-user project file, you set a password to protect the
project file. In a multi-user project file, you set a password to
prevent others from gaining access to your security level.
1

Open the file you want to protect with a password.
This step does not pertain to multi-user project files since the
password is tied to the user name—not the project file.

2

Choose Set Password from the File menu.
The New Password dialog box appears.
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3

Type your password and click OK.
The Verify Password dialog box appears.

4

Type the password again to confirm it, and click OK.
From now on, in a single-user project file, TestTrack
prompts you for the password before you can open the
project file. In a multi-user project file, TestTrack requires
you enter a password when you enter your user name.

Changing or removing a password
Periodically you may want to change your password.
Changing a password works the same for a single-user and a
multi-user project file.
1

Open the file whose password you want to change or
remove.
This step does not pertain to multi-user project files since the
password is tied to the user name—not the project file.

2

Choose Set Password from the File menu.
The Old Password dialog box appears.
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3

Type your old password and click OK.
The New Password dialog box appears.

4

Type a new password and click OK.
The Verify Password dialog box appears.

Note

5

If you want to remove the password, leave the field blank
and click OK. TestTrack removes the current password.
Type the password again to confirm it, and click OK.
TestTrack activates the new password immediately.
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Setting Preferences
The Preferences dialog box lets you set up TestTrack to work
the way you want it to:
1

Choose Preferences from the Edit menu.
The Preferences dialog box appears.

Note

42

In this chapter we describe how to set up the General,
Report, and User options. The Solo Bug options are
described in Chapter 12, “Working with Solo Bug.” The
Send Mail and Import Mail options are described in
Chapter 13, “Working with E-mail Notifications” and
Chapter 14, “Working with E-mail Import.”
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2

Select the General preferences.

The following describes the preferences:
Startup

Click Open previous file at startup to bypass the File Open
dialog box and have TestTrack open the last Project file you
used. Select the Automatically log in last user check box if
you also want TestTrack to bypass the User Name and
Password dialog box.
Click Show “file open” dialog box at startup to access the
File Open dialog box so you can choose the project file.

Closed defects

Check multi-user
project file

Click the check box if you want “Closed” defects grayed
out in the Defect list box.
Select the interval you want the multi-user project file
updated. See “Checking a project file,” later in this chapter,
for more information.
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3

Click the Report tab and select the Report preferences.

The following describes the preferences:
List reports
Detail reports
Tabular reports

44

Select the font you want to use for List reports.
Select the font you want to use for Detail reports.
Select the font you want to use for Tabular reports.
Distribution and Trend reports appear in tables and
therefore are called Tabular reports.
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4

Click the User tab and select the User preferences.

The following describes the preferences:
Notification
preferences

Click the Play sound when defect is assigned to me check
box if you want to be notified of new defects with a sound.
Click the Show message when defect is assigned to me
check box if you want to be notified of new defects with a
pop-up message.

Double-clicking

Click Open edit dialog box to open the Edit dialog box
when you double-click an item in a list box.
Click Open view dialog box to open the View dialog box
when you double-click an item in a list box.

Display names as

Click First Last to display user and customer names in first
name, last name order.
Click Last, First to display user and customer names in last
name, first name order.
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Send me
mail when

Click the Defects are assigned to me check box if you want
to receive e-mail when defects are assigned to you.
Click the Any defect changes check box if you want to
receive e-mail whenever a defect is edited.
Click the New defects are added check box if you want to
receive e-mail when defects are added to the project file.
Click the Don’t send me mail if I change or add a defect
check box if you don’t want TestTrack to send you e-mail
when you are the user who edited or added the defect.

5

Click OK.
Your new preferences take effect.

Configuring attachment settings
TestTrack supports the ability to attach multiple data files to
defects. These files are commonly called binary file
attachments. Binary file attachments often contain
information useful to fixing a defect or implementing a new
feature. Since binary files can contain any type of
information, they can be quite large. If they are stored in the
project file, the project file also becomes quite large and takes
much longer to backup and compact. TestTrack lets you
decide whether to store binary attachments in the project file
or in a sub-folder on your file server. You can change this
setting at any time, however, it is best to establish it up front
because changing it later can be time consuming. .
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To configure the attachment settings:
1

Choose Attachment Settings from Project Admin on the
File menu.
The Attachment Settings dialog box appears.

2

Select whether you want attachments stored in the project
file or in a separate folder.
If you elect to store attachments in a separate folder, the
folder must be a sub-folder of the folder containing the
project file. For example, if the project file is stored in Power
CD:TestTrack Data, the attachments may be stored in Power
CD:TestTrack Data:Attachments.
This requirement exists so all TestTrack users can access the
attachments sub-folder no matter what the server is called
relative to their Macintosh or PC configuration.

3

If you elected to store attachments in a separate folder,
enter the name of the folder.
The name can be up to 32 characters long.
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4

Click OK to save the settings.
The Attachment Settings dialog box closes. At this point, if
you are storing attachments in a separate folder and the
folder does not exists, TestTrack will create it for you.
Next, if you have changed where to store the attachments,
TestTrack either moves them from the project file to the subfolder or vise-versa.

Looking up project file information
To look up project file information:
1

Choose Project Info from the File menu.
The Project Information dialog box appears.

You may change the Project Name and Description. The
Project Name defaults to the name of the project file.
However, entering a new Project Name will not change the
name of the project file.
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The following describes the fields in the Project File
Information group box:
Location

Created
Modified
Size
Efficiency

This field shows where the project file is located on your
hard drive. It also lists the name of the project file. You may
find this information especially useful if you use the autoopen startup preference and have forgotten which file is
open. See “Setting preferences,” previous, to review the
Startup preference.
Shows the time the project file was created.
Shows the last time the project file was updated.
Shows the size of the project file.
When you delete an item in TestTrack, unused space is left
in the project file. This space is used when you add new
data, but sometimes many small spaces remain unused,
which results in a larger-than-necessary file size.
The percentage in this field shows you how efficient the
project file is. The higher the percentage, the better the
efficiency. A very low percentage (15%) indicates a file
with a lot of unused spaces in it. To fix this, choose
Compact Project from the File menu. See “Compacting a
project file,” next, for more information.

Security

2

Shows whether a file is a single-user project file (no
security), or a multi-user project file (security through user
groups). See Chapter 5, “Working with User Groups,” to
learn how to add security levels to a multi-user project file.
Choose OK.
The Project Information dialog box closes.
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Compacting a project file
When you delete an item in TestTrack, unused space is left in
the project file. This space is used when you add new data,
but sometimes many small spaces remain unused. After
prolonged use, this results in an inefficient file that is larger
than necessary.
To prevent this from happening, clean up the project file
periodically using the Compact Project command. This
command strips out the unused space in the project file and
reduces its size.
To find out how efficient the project file is, open the Project
Information dialog box and look at the percentage in the
Efficiency field. The higher the percentage, the better the
efficiency. A very low percentage (15%) indicates a file with
a lot of unused space in it. See “Looking up project
information,” previous, for information on the Project
Information dialog box.

Compact project files
with low Efficiency
percentages (15% or
lower).

To compact a project file:
Choose Compact Project from the File menu.
TestTrack compacts the project file. The Efficiency of the
project file is returned to 100%.
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Note

You can’t compact a project file while other users are
logged in.

Logging in another user
If you’re the project administrator, there may be times when
you need to log out the current user and log in another user
in the same project file without closing the project file.
Note

The Log In User command pertains only to multi-user
project files.
To log in another user:

1

Choose Log In User from the File menu.
The Welcome to TestTrack dialog box appears.

2

Enter a User Name and Password, and choose OK.
The new user is now the current TestTrack user.
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Listing active users
To display a list of those users who currently have a multiuser project file open:
1

Choose Show Active Users from the Activities menu.
The Active Users dialog box appears.

Note

2

This list pertains only to the project file you have open.
Other user may have other project files open and will not
appear in the list.
Choose OK.
The dialog box closes.
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Polling a project file
In a multi-user project file, TestTrack checks the project file
at defined intervals for changes and new data. For example,
it looks for new items, deleted items, and new defects
assigned to the current user.
You set the interval that TestTrack checks the project file in
the Preferences dialog box. TestTrack defaults to intervals of
every 10 seconds, but you can set it from every 30 seconds to
once an hour. See “Setting preferences,” earlier in this
chapter, to review.
If you set the preferences for a long interval between checks,
you can use the Check Project File command to check the
project file for new data and update it immediately.
To check a project file:
Choose Check Project File from the Activities menu.
TestTrack looks for new data and updates the project file
immediately.
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If you want to know more...
You may wonder why you would want to set a long
interval for the time TestTrack waits to check for new
data.
Because TestTrack is not a client-server based program,
it does not require a dedicated server to support
multiple users on a network. Therefore, if you are on a
slow network, or you have a lot of users on the network,
checking the project file every 10 seconds may bog down
TestTrack. In this case, it is best to increase the interval
TestTrack waits to check for new data.

Importing a file
TestTrack lets you import defects from comma- and tabdelimited files created in other database programs such as
FileMaker Pro.
To import defects in a database file:
1

Choose Import from Import on the File menu.
The Import dialog box appears.

54

TestTrack User Manual

2

Click Select File.
The Open dialog box appears.

3

Select the file you want to import.

4

Click Open.
The file appears in the Import dialog box. The column on the
left previews the fields as they appear in the file. Click the
Previous and Next arrow buttons to step through each
record.

This column lists the
fields as they appear
in the file you’re
importing.
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5

Select the Import options.
The following describes the options:

Delimitor

Ignore first
record
Handle quoted
text

Map vertical
tab to return

6

This option tells TestTrack whether comma or tab
characters are used to separate fields in a record.
Often the first record in a file contains field names. This
option tells TestTrack not to import the first record.
Often when you export a file from a database, quotes are
inserted around the comma- and tab-delimited records;
otherwise, a comma or tab appearing in a block of text (e.g.,
a description or note) would be misrepresented as a new
record. This option tells TestTrack to ignore commas and
tabs set off in quotes. If the program you used to export the
records supports quoting fields, select this option.
Some applications, such as FileMaker Pro, map carriage
returns in multi-line fields to vertical tab characters (ASCII
11). This option tells TestTrack to map the vertical tab
characters back to carriage returns to restore the proper
formatting of mult-line fields.

Match the TestTrack fields (in the right column) to the
fields from the file you are importing (in the left column);
or attach an Import Template.
To match the fields, click and drag the TestTrack fields in the
right column up or down to the proper position. If you can’t
find an exact match for the fields you are importing,
substitute its closest equivalent.
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Match the TestTrack
fields to the file
you’re importing by
dragging them to a
new position.

If you’ve already created an Import Template to match the
file’s format, load it now, and skip this and the next step.
See “Loading an Import Template,” later in this chapter, if
you need instructions.

Tip

7

Select which fields to import.
A checkmark beside a TestTrack field means TestTrack will
import that field. To select a field to import, click in the
middle column beside the field to make a checkmark appear.
Clicking the checkmark again toggles it off.

Click in the center
column to make a
checkmark appear.

Tip

If you are going to import a file using this layout again,
save this format as an Import Template. See “Creating an
Import Template,” next, for instructions.
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8

Click Import.
A progress window appears and lets you know the file is
being imported.

Creating an Import Template
If you import files with the same field layout often, save the
format as an Import Template.
To save a format as an Import Template:
1

Map the fields as described in “Importing a file.”

2

Click Save.
The Save Import Template dialog box appears.

3

Type a filename.

4

Click Save.
You return to the Import dialog box.
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Loading an Import Template
After you create an Import Template, you can select it at any
time. See “Creating an Import Template” if you have not
already created one.
To select an Import Template:
1

Click Load.
The Load Import Template dialog box appears.

2

Select the Import Template.

3

Click Open.
You return to the Import dialog box.

Exporting a file
You can export records in a TestTrack project file as a
comma- or tab-delimited text file.
To export a file:
Note

If you want to export just a few records (not the entire file),
select those records in the list window now. You can select
records from any list window (e.g., Defects, Users, User
Groups, Test Configs, etc.)

Chapter 3. Working with Project Files

59

1

Choose Export from the File menu.
The Export dialog box appears.

2

Tip

60

Select a record type from the Export pop-up menu.

If you’ve already created an Export Template to match the
file’s format, load it now, and skip this and the next step.
See “Loading an Export Template,” later in this chapter, if
you need instructions.
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3

Select the fields you want to export.

4

Repeat steps 2 and 3 for all the record types.

5

Select any options from the Export Options group box.
The following describes the options:

Export selected
records only

This option tells TestTrack to export only those records you
selected in the top-most list window (not all the records in
the project file).

Include column
headings

This option tells TestTrack to export the field names as the
first record.

Delimiter

This option tells TestTrack to insert either commas or tabs
between records.

Convert EOLs to
spaces

Tip

This option tells TestTrack to convert end of lines (a
carriage return or carriage return/line feed) to spaces. This
simplifies importing multi-line fields (e.g., defect
description) into programs that do not properly handle
fields with embedded carriage returns (e.g., Microsoft
Excel).

If you are going to export a file using this layout again,
save this format as an Export Template. See “Creating an
Export Template,” next, for instructions.
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6

Click Export.
The Export file dialog box appears.

7

Type a filename.

8

Click Save.
A progress window appears and lets you know the file is
being exported. You return to the Defects list window.

Creating an Export Template
If you export files with the same field layout often, save the
format as an Export Template.
To save a format as an Export Template:
1

62

Set up the fields as described in “Exporting a file.”
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2

Click Save.
The Save Export Template dialog box appears.

3

Type a filename.

4

Click Save.
You return to the Export dialog box.

Loading an Export Template
After you create an Export Template, you can select it at any
time. See “Creating an Export Template” if you have not
already created one.
To select an Export Template:
1

Click Load.
The Load Export Template dialog box appears.
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2

Select the Export Template.

3

Click Open.
You return to the Export dialog box.

Backing up your work
Since TestTrack is a multi-user program, many operating
systems will not allow you to make a copy of the project file
while someone is using it. TestTrack’s Backup Project File
command allows you to make a backup of your project file
while it is in use.
To back up your project file:
1

Choose Backup Project from the File menu.
The Backup Project File dialog box appears.

2

Type a filename.

3

Click Save.
A progress window appears and lets you know the file is
being backed up. You return to the Defects list window.
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Creating a project template
Configuring your project file’s field values, options, setting
security, user groups, users, reports, and e-mail notifications
may be easy, but it is time consuming. TestTrack allows you
to save all non-defect information in one project file to a new
file that you can use as a starting point for your next project.
This new file is called a project template. A project template
is a standard TestTrack project file without any defects in it.
Once created, you can open a project template and begin
adding defects to it or you can create and use a copy of it.
To create a project template from the current project file:
1

Choose Save Project Template from the File menu.
The Save Project Template dialog box appears.

2

Type a filename.

3

Click Save.
A progress window appears and lets you know the file is
being created. When the progress window disappears, your
project template is ready for use.
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Making a single-user project file multi-user
When you first create a project file, you specify whether the
file is single-user or multi-user. The Make Multi-User/Make
Single-User command allows you to easily toggle the
database from single- to multi-user and back.
To make a single-user project file multi-user:
1

Select Make Multi-User from Project Admin on the File
menu.
The current project file is updated to support multiple users.
A default administrator user called ‘admin’ is added to the
project file along with no password. A user group called
‘administration’ with full security access rights is also added.

2

Close the project file and re-open it.
You will be required to log into the project file. Remember to
enter the default user name of ‘admin’ and leave the
password field empty.
To make a multi-user project file single-user:

1

Select Make Single- from Project Admin on the File menu.
The current project file is updated to support only a single
user.

2

Close the project file and re-open it.
You will not be required to log into the project file and only
one user will be able to access it at a time.
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Recovering a damaged project file
Sometimes, no matter how hard you try to prevent them,
bad things happen to nice people. Fortunately, TestTrack
provides a low-level database recovery feature to restore
your data in the event your project file is corrupted by a
server crash or some other software or hardware problem.
Remember, a database recovery command is no substitute
for a good backup routine. Catastrophic crashes can corrupt
a project file beyond repair. However, if your database does
become corrupt, recovery is always worth trying.
To recover a corrupt project file:
1

Create a backup of your project file using your operating
systems copy command.
This should be your first step whenever you suspect a
corrupt project file. Always try to create the backup copy on
another hard disk drive to ensure you do not further damage
the drive on which the project file resides.

2

Choose Recover Project from Project Admin on the File
menu.
The Save Recovered Database dialog box appears.
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2

Type a filename for the recovered file.

3

Click Save.
A progress window appears and lets you know the file is
being created. When the progress window disappears, your
project template is ready for use.
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4

Working with Defects

Contents

Squash the bugs...

About defects
Defect life cycles
Defect actions
Deferred defect numbering
Filtering defects
Adding a defect, multiple
reports, & duplicates
Attaching a file
Merging defects
Viewing a defect
Going to/finding defects
Changing defect
Deleting a defect
Assigning a defect
Estimating
Fixing a defect
Verifying a defect
Re-opening a defect
Closing a defect
Adding comments to a defect
Adding release notes
Changing a defect action
Deleting a defect action
Renumbering a defect

...and make way for enhancements! TestTrack
lets you track all aspects of defect management,
which means long-forgotten bugs don’t surface
just before a release, and great ideas don’t end up
on scraps of paper in a trash can.
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You can assign a responsible person to fix or
verify a defect. In multi-user project files,
TestTrack notifies a user as soon as he or she
receives a defect assignment. Since
communication is automatic, defects are not lost
or forgotten about. You can also prioritize
defects according to their severity, and move a
defect through a life cycle.
This chapter explains how to work with defects.
It starts with an explanation of a defect and how
defect actions move a defect through a life cycle.
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About defects
A defect is a bug, enhancement, change request or any other
product-related issue you wish to remember and resolve.
Depending on your needs, you can configure complex
tracking methods or simply use TestTrack as a bug “to-do”
list. Whichever your choice, knowing a few of TestTrack’s
capabilities will help start you on your way:
Life Cycle

Most defects have a definite life cycle. A life cycle
defines the path a defect takes from the initial bug report
to a final resolution and consists of states. See
“Understanding a defect’s life cycle” for more
information.

Defect Action

To move a defect from one state to another, you must
assign a defect action. See “Taking a look at defect
actions” for more information.

Deferred Defect
Numbering

TestTrack can delay numbering defects until you
determine they belong in the database. See “Deferred
defect numbering” for more information. .

Communication

In a multi-user file, any time you assign a defect to a
responsible person, TestTrack automatically notifies that
user of his or her new responsibility. See
“Communicating with others” for more information.

Filters

A filter helps you manage the data listed in the Defects
list window. A filter “filters out” unwanted defects and
lets those you want to see pass through to the list
window. See “Filtering out unwanted defects” for more
information.

Understanding a defect’s life cycle
A life cycle defines the path a defect takes from initial
reporting to a resolution and consists of states. In TestTrack,
a defect is always in one of the following six states:
Open
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A defect in the Open state has been added to the project
file, but it has not been fixed or closed.
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Fixed
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A defect in the Fixed state has been fixed or resolved and
is pending verification.
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Verify Passed

A defect in the Verify Passed state has had its resolution
successfully verified and the defect is now closed.

Verify Failed

A defect in the Verify Failed state did not pass
verification. The defect must be fixed again and returns
to the Open state.

Closed

There was no reason to fix and verify the defect. It may
not have been a defect, or it may be a requested feature
you do not plan to add to the product.

Re-opened

The defect has resurfaced after it was resolved and
verified or closed.

Taking a look at defect actions
Defects must progress through life cycle states before they
are “resolved.” To move a defect from one state to another,
you must assign a defect action.
You can assign the following defect actions to a defect:
Assign
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Assigns a responsible person to fix a defect.

Estimate

Allows you to estimate the time needed to fix a defect or
implement a new feature.

Fix

Moves the defect into the Fixed state. When you use this
command, you can also Save & Assign the defect to a
new responsible person for verification.

Verify

Lets you choose whether the defect’s resolution passes or
fails. If you choose Fail, you can also Save & Assign the
defect to a new responsible person to fix.

Close

Overrides the life cycle and closes out a defect. You can
choose this command any time in a defect’s life cycle.
This command is ideal if you discover a reported defect
is not an actual defect.
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Reopen

Re-opens a defect that has resurfaced after it was
verified or closed.

Release

Automatically generates a text file of release notes.

Comments

Allows you to add special comments to any defect.
Defect actions allow you to move a defect from one state in
its life cycle to another. You can assign a defect to a
responsible person to fix, and TestTrack automatically
notifies that user of his or her new responsibility. Likewise, if
another user assigns a defect to you, you automatically
receive a message telling you so. After you fix the defect, you
can assign it to another lucky user for verification.

The defect action
buttons let you
move a defect
through its life
cycle.
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All the defect actions you perform on a defect become part of
the defect’s history. You can view the defect’s history on the
History Tab located on the Add, View, and Edit dialog
boxes. If you need to, you can edit or delete defect actions
from the History tab. See “Changing a defect action” or
“Deleting a defect action,” later in this chapter, for
instructions.

The following graphic shows how you can assign defect
actions to move a defect through its life cycle:
Add a defect to the
project file...

...and assign a responsible
person to fix the defect.

Assign
Close

The responsible person
marks the defect Fixed....

Fix

...and assigns a new
responsible person to verify
the fix.

Assign

That responsible person
verifies the fix and chooses
either “Pass” or “Fail.”

Verify

Start
over

Chose Close
to override
the life cycle
and close out
a defect. You
may choose
this command
at any time.

Fail
Pass

Closed
If a defect resurfaces...
...choose Re-open to start
the procedure over.
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Deferred defect numbering
During product testing, bug reports are coming in rapidly
from a variety of sources. Many are new bugs or feature
requests that you need to track, some are neither unique nor
issues you need to track in the project file. TestTrack
provides the ability to store new defects in the project file,
but not number them until they have been confirmed as
unique defects. This feature is called deferred defect
numbering.

Configuring deferred defect numbering
To set up defect numbering:
1

Select Defect Numbering from Project Admin on the File
menu.
The Defect Numbering dialog box appears.
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2

Specify when defect numbers should be assigned to
defects.
The following describes the options:

Submitted by
TestTrack Users
Imported from
Solo Bug

Imported via
e-mail

3

A defect number is assigned whenever a defect is added by
a TestTrack user.
A defect number is assigned to defects imported as Solo
Bug files; either automatically, using the Load Solo Bug
Files command, or dropped on the defect list window.
A defect number is assigned to defects imported from an email account. This also applies to e-mail text files that are
imported by dropping them on the defect list window.

Optionally specify the next defect number to use.
You can set the next defect number to any value greater than
the largest defect number used in the project file.

4

Click OK to save the settings.
The Defect Numbering dialog box closes and your settings
are saved to the project file.

Using deferred defect numbering
When deferred defect numbering is active, new defects
appear in the defect list with a dash in the column where the
defect number normally appears. They are called
unnumbered defects. When sorting the defect list by defect
number, unnumbered defects are treated as if they were
numbered lower than any other defect. .
You can perform any action on an unnumbered defect that
you can perform on a numbered defect. Normally, you will
periodically review the unnumbered defects and take one of
the following actions: merge them with existing defects,
delete them, or assign them unique defect numbers.
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The following describes each action:
Merging Defects

If an unnumbered defect is not unique (is a duplicate), you
should merge it with the existing identical defect. See
“Merging defects,” later in this chapter, to learn how to
merge two or more defects.

Deleting Defects

If an unnumbered defect does not belong in the project file,
you should delete it. Perhaps the defect does not relate to
any of the products or projects tracked in the project file.
Or, maybe it was unsolicited e-mail offer that found its way
to your technical support e-mail account. See “Deleting a
defect,” later in this chapter, to learn how to delete a defect.

Assign Defect
Numbers

If the unnumbered defect is unique and belongs in the
project file, you can assign the next available defect number
to it. See “Assigning defect numbers,” next, to learn how
to number a defect.

Assigning defect numbers
To assign a number to an unnumbered defect:
1

Select the defect you want to number from the Defects list
window.
To select a range of defects, click the first item in the range,
then shift-click the last item. To select multiple items not in
a range, command-click each item.

2.

Select Assign Defect Numbers from Defect Actions on the
Activities menu.
The defect is assigned the next defect number.
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Communicating with others
In multi-user project files, when you assign a defect to a
responsible person, TestTrack automatically notifies that
user of his or her new responsibility. Likewise, if another
user assigns a defect to you, you automatically receive a
message telling you so. Defect indicators appear in the first
column of the Defects list window and point out new
defects, closed defects, and defects assigned to you:

This defect is
new since you
last logged in.
This defect
changed since you
last logged in.
This defect is
assigned to you.
This defect is
closed.

For more information on defect indicators, see “Looking at
defect indicators” in Chapter 2, “Learning the Basics.”
Note
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Notice that the closed defect is grayed out. You can set this
preference in the Preference dialog box. See “Setting
preferences” in Chapter 3, “Working with Project Files.”
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Filtering out unwanted defects
As you and others add more and more defects to a project
file, it gets harder to find specific defects in the Defects list
window “at a glance.” To get TestTrack to list only those
defects you want to see, use a filter.

You can create a filter to meet every need you may have.
You can also share the filters others have created. The
combination and content of filters you can create is limitless.
To learn how to create filters, see Chapter 7, “Working with
Filters.”
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Adding a defect
To add a defect:
1

Choose Defect from the Create menu, or click the Add
button on the Defects list window.
The Add Defect dialog box appears.

2.

Enter the information in the top portion of the dialog box.
The following describes each field:

Summary

Status

Type
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Enter a summary for the defect You may use up to 255
characters.
Display-only field. Displays the current state of the defect
and whether it’s assigned.
Select the defect’s type from the pop-up menu. TestTrack
comes with default values. You may use these, or you may
customize them. See “Configuring field values” in Chapter
3, “Working with Project Files,” if you want to change or
add values.
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Priority

Select the defect’s priority from the pop-up menu.
TestTrack comes with default values. You may use these,
or you may customize them. See “Configuring field
values” in Chapter 3, “Working with Project Files,” if you
want to change or add values.

Product

Select the name of the product from the pop-up menu.
Since these values are specific to your company, TestTrack
does not come with default values. However, TestTrack
adds the name of your project file to the list to get you
started. To add a product name to the pop-up menu, see
“Configuring field values” in Chapter 3, “Working with
Project Files.”

Component

Reference

Select the name of the component from the pop-up menu.
Since these field values are specific to your project,
TestTrack does not come with default component values.
To add a component name to the pop-up menu, see
“Configuring field values” in Chapter 3, “Working with
Project Files.”
Enter any reference number pertinent to the defect.

Severity

Select the defect’s severity from the pop-up menu.
TestTrack comes with default values. You may use these,
or you may customize them. See “Configuring field
values” in Chapter 3, “Working with Project Files,” if you
want to change or add values.

Entered by

Defaults to the current user; however, you may select any
user from the pop-up menu.

Date Entered

3

Defaults to the current date; however, you may enter a
different date.
Enter the information on the Detail tab.
The Current Report field defaults to the current user;
however, you may select any user from the pop-up menu.
Notice the buttons in the top-right corner of the Detail tab.
These buttons allow you to add multiple reports of the same
defect. You learn how to use this functionality in the next
topic, “Adding multiple reports of a defect.”
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The Detail tab is made up of four mini tabs.
A mini tab is a small,
horizontally oriented
tab. Icons illustrate
the functionality.

These buttons allow you
to enter multiple reports
of the same incidence.
Read about this in the
next topic.

4

Enter the information on the Reported by mini tab.

The following describes each field:
Reported by

Date

Version
Description

5
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Defaults to the current user; however, you may select any
user from the pop-up menu.
This field defaults to the current date. You may enter a new
date if you wish.
Enter the version of the software containing the defect.
Enter a detailed description of the defect.
Enter the information on the Steps to Reproduce mini tab.
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The following describes each field:
Reproduced

Steps to
Reproduce

6

Select a reproducible level from the pop-up menu.
TestTrack comes with default values. You may use these,
or you may customize them. See “Configuring field
values” in Chapter 3, “Working with Project Files,” if you
want to change or add values.
Enter the detailed steps to reproduce the problem. Be as
specific as possible.
Enter the information on the User’s Computer
Configuration mini tab.

The following describes each field:
Computer Config

Defaults to the current user’s test configuration; however,
you may select any configuration from the pop-up menu. If
you need to add a new configuration, see “Adding a test
configuration” in Chapter 8, “Working with
Configurations.”

Other Hardware
and Software

Enter information about any other hardware and software
involved with the problem.

7

Chapter 4. Working with Defects

Attach a file to the defect using the Attachments mini tab.
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To attach a file:
1.

Click Attach. The Attach File dialog box appears.

2.

Find the file and select it.

3.

Click Attach. The file appears in the Attachments list
box on the Attach File dialog box.

See “Attaching a file to a defect,” later in this chapter, for
details and other important information.

Ä
8

Where to go next...
At this time, you can assign a responsible person to fix
the defect. Click the Assign button located at the bottom
of the dialog box. The Assign Defect dialog box appears.
See “Assigning a responsible person,” later in this
chapter, for instructions.
Click the History tab.
This tab shows you a complete history of all the defect
actions. This box remains blank until you assign a defect
action. If you just assigned a responsible person to fix the
defect, the action appears in the list box.
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Where to go next...
If you made a mistake in the defect action dialog box, or
you want to add more information, you can edit the
defect action from the History tab. See “Changing a
defect action,” later in this chapter, for instructions.
You can also delete the defect action. See “Deleting a
defect action,” later in this chapter, for instructions.

9

Click the Workaround tab.
Enter a workaround fix for the problem.

10

Click the Notify tab.
This tab allows you to define a list of users and customers
who will receive e-mail whenever the defect changes.
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To add users to the notification list:

11

1.

Click Add. The Add Mail Recipients dialog box appears.

2.

Click the Users and/or Customers check boxes to
control who appears in the list.

3.

Highlight the names of the users and/or customers who
you want to notify of changes to this defect.

4.

Click Add. The dialog box disappears and the selected
user and customer names are added to the Send mail to
list box

Click the Add button.
The defect is added to the project file. The cursor returns to
the Summary field and you are ready to add another defect.
TestTrack uses sticky fields to retain data and save you time
when you are entering similar defects.
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If you want to know more...
If you are in the process of adding old bug reports to
TestTrack, you can enter their complete histories (e.g.,
who found the defect, who fixed it and when, who
verified it, etc.) without ever leaving the Add Defect
dialog box. The following explains:
1. From the Add Defect dialog box, enter the Summary,
Type, and Priority.
2. Enter the information on the Detail tab and the Test
Config tab.
3. Click the History tab and choose the defect action that
best describes the first state in the defect’s history. For
example, choose Assign. The Assign Defect dialog box
appears. Enter the information and choose OK.
4. Continue entering the defect’s history (Fix, Verify
Passed/Fail, etc.). If you make a mistake on an item,
select the item and choose Edit Action from the Edit
menu. See “Changing a defect action,” later in this
chapter, for details.

Adding multiple reports of a defect
Often the same defect is reported by several users,
customers, or beta sites. To help you avoid unnecessary
duplicates in your database, you can add the defect once and
add all other reports of the defect as subreports.
To add a multiple report of a defect:
1

Select the defect you want to add an additional report to.
If you are currently adding the main defect skip to step 3.

2

Choose Edit Defect from the Edit menu, or click the Edit
button on the Defects list window.
The Edit Defect dialog box appears.
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3

On the Detail tab, click New.

Click here to enter
multiple reports of the
same defect.

The Current Report field reflects the name and date of the
defect visible in the mini tabs. It clears to “Unknown” until
you select a name in the Reported by field (on the mini tab).
4

Select a user from the pop-up menu on the Reported by
mini tab.

Select a user for
the new report.

5

Enter a description and any other pertinent information on
the mini tabs.

6

Click OK.

Duplicating a defect
When you duplicate a defect, TestTrack makes an exact copy
of the defect and assigns it a new defect number. You can
then modify it in any way.
To duplicate a defect:
1
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Select the defect you want to duplicate from the Defects
list window.
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2

Choose Duplicate Defects from the Edit menu.
TestTrack duplicates the defect, assigns it a new defect
number, and places it at the end of the list.

Attaching a file to a defect
The more information you supply with a defect report, the
easier it is to fix it. For example, if a defect is corrupting a
file, you could attach the corrupt data file for reference, or if
you want to point out a cosmetic change to a screen, you
could attach a screen snapshot.
You can attach as many files as you need to a defect.
However, to save you time, you may want to zip all the
files together and attach the zipped file.

Tip

To attach a file to a defect:
1

Select the defect you want to attach a file to.
If you are currently adding or editing the defect skip to
step 3.

2

Choose Edit Defect from the Edit menu, or click the Edit
button on the Defects list window.
The Edit Defect dialog box appears.

3
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On the Detail tab, click the Attachments mini tab.
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4

Click the Attach button.
The Attach File dialog box appears.

Select a file to
attach.

5

Find the file you want to attach and select it.

6

Click the Attach button.
The file appears in the Attachments list box on the Attach
File dialog box

7

Click OK.

Extracting an attached file from a defect
Extract allows you to save a copy of an attachment to your
hard disk drive. For example, if a customer attaches a
corrupted data file to a defect, you can extract the file to a
folder on your hard drive. You can then access the file to
debug the problem.
To extract an attached file from a defect:
1

Select the defect you want to extract an attached file from.

2

Choose Edit Defect from the Edit menu, or click the Edit
button on the Defects list window.
The Edit Defect dialog box appears.
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3

On the Detail tab, click the Attachments mini tab.

4

Select the attached file.

5

Click the Extract button.
The Save Extracted File As dialog box appears.

6

Make sure the correct folder is selected, and check the file
name.
You can keep the assigned folder and file name, or you can
select a new folder and type a new filename.

7

Click the Save button.
TestTrack copies the attached file to the folder you selected.
You can now use the file.
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Viewing an attached file
TestTrack allows you to view text and graphics files without
first extracting them. Specifically, you can view text files
with a type of ‘TEXT’ and graphics files with a type of
‘PICT’.
To view an attached file from a defect:
1

Select the defect you want to view an attached file from.

2

Choose Edit Defect from the Edit menu, or click the Edit
button on the Defects list window.
The Edit Defect dialog box appears.

3

On the Detail tab, click the Attachments mini tab.

4

Select the attached file.
You can select either text files (type ‘TEXT’) or graphics files
(type ‘PICT’).

5

Select View Attachment from the Edit menu.
The text file or graphics file is displayed.
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Deleting an attached file from a defect
To remove an attached file from a defect:
1

Select the defect you want to remove an attached file from.
If you are on the Edit Defect dialog box, skip to step 3.

2

Choose Edit Defect from the Edit menu, or click the Edit
button on the Defects list window.
The Edit Defect dialog box appears.

3

On the Detail tab, click the Attachments mini tab.
All the attached files appear in the list box.

4

Select the file you want to delete.

5

Click the Remove button.
The attached file is removed.

Merging defects
To eliminate duplicate defects, you can merge two or more
defects into one:
To merge duplicate defects:
1

Select the defects you want to merge from the Defects list
window.
To select a range of defects, click the first item in the range,
then shift-click the last item. To select multiple items not in
a range, command-click each item.
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2

Choose Merge Defects from the Edit menu.
A warning box appears.

3

Choose OK.
If the defects differ in type, priority, severity, reference, or
duplicate, a message appears after the merge so you can
review the resulting defect. The other defects are deleted.

Note
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TestTrack merges the selected defects into one defect. The
defect assumes the lowest defect number and the
summary, status, product, component, reference, and dates
from that defect. The defect assumes the “worst case” type,
priority, and severity. The information on all the tabs is
retained as multiples reports of the same defect. For
example, if you merged 3 defects, the Detail tab will show
3 reports, which you can select from the Current Report
pop-up menu.
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Viewing a defect
To view a defect:
1

Select the defect you want to view from the Defects list
window.
To select a range of defects, click the first item in the range,
then shift-click the last item. To select multiple items not in
a range, command-click each item.
If the View button is bold, double-click the defect to select
it and open the View Defect dialog box at the same time.
You can set this preference in the Preferences dialog box.

Tip

2

Choose View Defect from the Edit menu, or click the View
button on the Defects list window.
The View Defect dialog box appears.

Note
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When viewing or editing a defect, next and previous
arrows appear at the bottom of the dialog box. Click the
arrows to page through the defects.
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3

Choose OK.
The View Defect dialog box closes.

&

If you want to know more...
Use the History tab to view the complete history of a
defect. The History tab lists every defect action
performed on the defect.
If you need to edit a defect action, see “Changing a
defect action,” later in this chapter, for details.

Going to a specific defect
To go quickly to a specific defect:
1

Choose Go To Defect Number from the Edit menu.
The Go To Defect Number dialog box appears.

2

Enter the defect number.

3

Click OK.
The Edit Defect dialog box for that defect appears.
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Finding defects
The Find Defects dialog box lets you search the Summary or
Description fields for text that you specify.
To use the Find Defects command:
1

Choose Find Defects from the Edit menu, or click the Find
button located on the toolbar.
The Find Defects dialog box appears.

2

Choose either Summary or Description from the Field popup menu.

3

Enter the text you want to search on in the Contains field.

4

Select a radio button in the When Defects are Found group
box.
Your choices are as follows:

Select in defect list

TestTrack selects the defects in the Defects list window.

Open to view

TestTrack selects the defects and opens them in the View
dialog box.

Open to edit

TestTrack selects the defects and opens them in the Edit
dialog box.
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5

Choose Find.
TestTrack searches for the text you entered in the Contains
field.

Changing a defect
To change a defect:
1

Select the defect you want to change from the Defects list
window.
To select a range of defects, click the first item in the range,
then shift-click the last item. To select multiple items not in
a range, command-click each item.
If the Edit button is bold, double-click the defect to select
it and open the Edit Defect dialog box at the same time.
You can set this preference in the Preferences dialog box.
You only can double-click single items.

Tip

2

Choose Edit Defect from the Edit menu, or click the Edit
button on the Defects list window.
The Edit Defect dialog box appears.
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Note

3

When viewing or editing a defect, next and previous
arrows appear at the bottom of the dialog box. Click the
arrows to page through the defects.
Make any changes.
If another user is editing the defect, a Read-only icon
appears next to the Cancel button. You can’t edit the defect
until the other user is finished and the Read-only icon
disappears. Click on the icon to see who is editing the defect.

Click on the icon to see who is editing the defect.

Ä
4

Where to go next...
You can choose a defect action from the bottom of the
dialog box. See “Assigning a responsible person,”
“Fixing a defect,” “Verifying a defect,” “Re-opening a
defect,” or “Closing a defect.”
Choose OK.
The Edit Defect dialog box closes. Your changes have been
made.

Chapter 4. Working with Defects

99

Deleting a defect
To delete a defect:
1

Select the defect you want to delete from the Defects list
window.
To select a range of defects, click the first item in the range,
then shift-click the last item. To select multiple items not in
a range, command-click each item.

2

Choose Delete Defect from the Edit menu, or click the
Delete button on the Defects list window.
The defect is removed from the Defects list window.

Deleting a report of a defect from a list of multiples
To remove a report of a defect from the list of multiples:
1

Select the defect you want to remove one of the additional
reports from.
If you are on the Edit Defect dialog box, skip to step 3.

2

Choose Edit Defect from the Edit menu, or click the Edit
button on the Defects list window.
The Edit Defect dialog box appears.

3

On the Detail tab, select the report you want to remove.

Select the user’s
report you want to
remove.

You can also use
these arrows to page
through the reports.

4

Click the Remove button.
The report is removed from the list.
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5

Click OK.

Assigning a responsible person
To assign a responsible person to fix or verify a defect:
1

Select the defect from the Defects list window and choose
Assign from Defect Actions on the Activities menu; or
click the Assign button on the Add or Edit Defect dialog
box.
The Assign Defect dialog box appears.

2

Select a responsible person from the Assign To pop-up
menu.
If you need to add a new user to the menu, choose New User
from the pop-up menu. See “Adding a user” in Chapter 6,
“Working with Users,” for instructions. Pick up at step 2.

3

Check the date, and enter any notes pertaining to the
defect.
The date defaults to the current date, but you may enter
another date. The notes are recorded with the history of the
defect. It’s always best to specify too much detail, rather than
too little!
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4

Choose OK.
You return to the Add or Edit Defect dialog box. Choose
Add in the Add Defect dialog box; or OK in the Edit Defect
dialog box.

Note

If you are working with a multi-user project file, TestTrack
notifies the user of the new defect assigned to him or her.

Estimating the time needed to fix a defect
To enter an estimate of the time needed to fix a defect:
1

Select the defect from the Defects list window and choose
Estimate from Defect Actions on the Activities menu; or
click the Estimate button on the Add or Edit Defect dialog
box.
The Estimate Defect dialog box appears.

2

Select a user from the Estimate provided by pop-up menu.
If you need to add a new user to the menu, choose New User
from the pop-up menu. See “Adding a user” in Chapter 6,
“Working with Users,” for instructions. Pick up at step 2.
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3

Check the date.
The date defaults to the current date, but you may enter
another date.

4

Enter the Estimated time to complete and the Estimated
completion date or version.
The date defaults to the current date, but you may enter
another date.

5

Enter any notes in the Assumptions box.
The notes are recorded with the history of the defect. It’s
always best to specify too much detail, rather than too little.

6

Choose OK.
You return to the Add or Edit Defect dialog box. Choose
Add in the Add Defect dialog box; or OK in the Edit Defect
dialog box.

Fixing a defect
To indicate a defect is fixed:
1

Select the defect from the Defects list window and choose
Fix from Defect Actions on the Activities menu; or click
the Fix button on the Add or Edit Defect dialog box.
The Fix Defect dialog box appears.
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2

Select a user from the Fixed By pop-up menu.
If you need to add a new user to the menu, choose New User
from the pop-up menu. See “Adding a user” in Chapter 6,
“Working with Users,” for instructions. Pick up at step 2.

3

Check the date.
The date defaults to the current date. However, you may
enter another date if you prefer.

4

Enter a version number.
Enter the version of the product in which the defect was
found.

5

Select a resolution from the Resolution pop-up menu.
TestTrack comes with default resolution values. You may
use these, or you may customize them. See “Configuring
field values” in Chapter 3, “Working with Project Files,” if
you want to add or change values.

6

Enter the Hours to Fix.
You may find this information useful for future planning
and for estimating the time it will take to fix similar defects.

7

Select the Affects Documentation check box or the Affects
Test Plan check box if either apply.
To help your documentation team keep up to date, be sure to
supply this information.

104

TestTrack User Manual

8

Choose Save & Assign, or OK.
The following explains your choices:

Save & Assign

Choose Save & Assign to save your work and assign the
defect to a responsible person to verify. The Assign Defect
dialog box appears. Fill in the fields on the dialog box and
choose OK. You return to the Defects list window.

OK

If you’re not ready to assign the defect to a responsible
person to verify, choose OK. You return to the Edit Defect
dialog box; choose OK. You can edit the defect later and
assign a responsible person then.

Verifying a defect
After a user fixes a defect, another user should verify that
the “fix” actually resolves the problem. The verification step
results in one of two possible outcomes:
• The defect passed the verification and can be closed.
• The defect failed the verification and still needs to be fixed.
To indicate a fixed defect has passed or failed verification:
1

Select the defect and choose Verify from Defect Actions on
the Activities menu; or click the Verify button on the Add
or Edit Defect dialog box.
The Verify Defect dialog box appears.
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2

Select a user from the Verified By pop-up menu.
To add a new user to the menu, choose New User from the
Verified By pop-up menu. See “Adding a user” in Chapter
6, “Working with Users,” for instructions. Pick up at step 2.

3

Check the date.
The date defaults to the current date. However, you may
enter another date if you prefer.

4

Enter an explanation in the Notes field.
It’s a good idea to record why the defect failed. It may help
you make a decision in future planning.

5

Choose either the Pass or Fail radio button.

Be sure to select
a radio button.
TestTrack defaults
to Pass.

The following describes what to do for each choice:
Pass

When you choose Pass, your work is finished. Choose OK
to close the Verify Defect dialog box.

Fail

When you choose Fail, the Save & Assign button becomes
active. Choose Save & Assign to save your work and
assign the defect to a responsible person to fix.
The Assign Defect dialog box appears. Fill in the fields on
the dialog box and choose OK.

6

Choose OK.
The status in the Defects list window shows the defect
passed verification and is Closed. The defect is also grayed
out, if you chose the option in the Preferences dialog box.
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Note

If you need to re-open the defect, you can. See “Re-opening
a defect,” next, for instructions.

Re-opening a defect
Occasionally, a closed or verified defect resurfaces. To return
the defect to the Open state and start its life cycle over, you
need to re-open it.
To re-open a closed or verified defect:
1

Select the defect from the Defects list window and choose
Re-open from Defect Actions on the Activities menu; or
click the Re-open button on the Add or Edit Defect dialog
box.
The Re-Open Defect dialog box appears.

2

Select a user from the Re-opened By pop-up menu.
To add a new user to the menu, choose New User from the
Verified By pop-up menu. See “Adding a user” in Chapter
6, “Working with Users,” for instructions. Pick up at step 2.

3

Check the date.
The date defaults to the current date. However, you may
enter another date if you prefer.

Chapter 4. Working with Defects

107

4

Enter an explanation in the Notes field.
It’s a good idea to record why you re-opened the defect. It
may help you make a decision in future planning.

5

Choose Save & Assign, or choose OK.
The following explains your choices:

Save & Assign

OK

Choose Save & Assign to save your work and assign the
defect to a responsible person to fix. The Assign Defect
dialog box appears. Fill in the fields on the dialog box and
choose OK. You return to the Defects list window.
If you’re not ready to assign the defect to a responsible
person to fix, choose OK. You return to the Edit Defect
dialog box; choose OK. You can edit the defect later and
assign a responsible person then.

Closing a defect
The resolution of some defects does not follow the standard
fix/verify model. For example, a defect whose type is “not a
bug” does not need to be fixed. In this situation, close the
defect.
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To override the standard life cycle and close a defect:
1

Select the defect from the Defects list window and choose
Close from Defect Actions on the Activities menu; or click
the Close button on the Add or Edit Defect dialog box.
The Close Defect dialog box appears.

2

Select a user from the Closed By pop-up menu.
To add a new user to the menu, choose New User from the
Verified By pop-up menu. See “Adding a user” in Chapter
6, “Working with Users,” for instructions. Pick up at step 2

3

Check the date.
The date defaults to the current date. However, you may
enter another date if you prefer.

4

Select a resolution from the Resolution pop-up menu.
TestTrack comes with default resolution values. You may
use these, or you may customize them. See “Configuring
field values” in Chapter 3, “Working with Project Files,” if
you want to add or change values.

5

Enter an explanation in the Notes field.
You should explain why you closed the defect for historical
purposes.

6
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Adding release notes a defect
To add release notes to a defect:
1

Select the defect from the Defects list window and choose
Release Notes from Defect Actions on the Activities menu;
or click the Release Notes button on the Add or Edit
Defect dialog box.
The Release Notes dialog box appears.

2

Select a user from the Entered by pop-up menu.
If you need to add a new user to the menu, choose New User
from the pop-up menu. See “Adding a user” in Chapter 6,
“Working with Users,” for instructions. Pick up at step 2.

3

Enter the version the release note pertains to.

4

Check the date.
The date defaults to the current date, but you may enter
another date.
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5

Enter the release notes.
The notes are recorded with the history of the defect.
Remember, these notes are intended for the end users of
your application. Therefore, be specific and use as little
jargon as necessary.
You can generate a file containing all the release notes for a
specific version, date, etc. You can insert this file in your
Read-me file or use it to create a separate Release Note
guide. See “Generating release notes” in Chapter 10,
“Working with reports,” to learn how.

Tip

6

Choose OK.
You return to the Add or Edit Defect dialog box. Choose
Add in the Add Defect dialog box; or OK in the Edit Defect
dialog box.

Adding comments to a defect
To add a comment to a defect:
1

Select the defect from the Defects list window and choose
Comments from Defect Actions on the Activities menu; or
click the Comments button on the Add or Edit Defect
dialog box.
The Comments dialog box appears.
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2

Select a user from the Comment by pop-up menu.
If you need to add a new user to the menu, choose New User
from the pop-up menu. See “Adding a user” in Chapter 6,
“Working with Users,” for instructions. Pick up at step 2.

3

Check the date.
The date defaults to the current date, but you may enter
another date.

4

Enter the comments.
The notes are recorded with the history of the defect. You
can view them later on the History tab.

5

Choose OK.
You return to the Add or Edit Defect dialog box. Choose
Add in the Add Defect dialog box; or OK in the Edit Defect
dialog box.

Changing a defect action
If you made a mistake in the defect action dialog box, or if
you simply want to add more information to a note box, you
can edit the defect action. For example, if a resolution to a
defect affected documentation, but you forgot to select the
Affects Documentation check box, you can edit the defect
action and select the check box.
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To edit a defect action:
1

Select the defect from the Defects list window and choose
Edit.
The Edit Defect dialog box appears.

2

Click the History tab.
A list of all the actions performed on the defect appears.

3

Select the defect action you want to change.

4

Choose Edit Action from the Edit menu.
A dialog box for the defect action you chose appears.
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5

Make any changes.

6

Choose OK.
You return to the Edit Defect dialog box.

7

Choose OK.
You return to the Defects list window.

Deleting a defect action
To delete a defect action:
1

Select the defect from the Defects list window and choose
Edit.
The Edit Defect dialog box appears.

2

Click the History tab.
A list of all the actions performed on the defect appears.

3

114

Select the defect action you want to delete.
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4

Choose Delete Action from the Edit menu.
The defect action is deleted from the History tab on the Edit
Defect dialog box.

5

Choose OK.
You return to the Defects list window.

Renumbering a defect
Over the course of working with your project file, you may
delete or merge defects leaving holes in the sequence of
defect numbers. Or, at the start of a new development cycle,
you may wish to purge all closed defects from the project file
and use it as a fresh starting point for your testing efforts.
TestTrack provides the ability to renumber your defects at
any time.
To renumber a defect:
1

Select the defect you want to renumber from the Defects
list window.
To select a range of defects, click the first item in the range,
then shift-click the last item. To select multiple items not in
a range, command-click each item.

2

Select the Renumber Defects from Defect Actions on the
Activities menu.
The Renumber Defects dialog appears with the starting
number set to the next available defect number.
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3

Enter a new number for the defect.
Enter an unused defect number.

4

Click OK.
The Renumber Defects dialog closes and the defect is
renumbered.
If the renumbered defect’s number is higher than the next
available defect number, the next available defect number is
set to one higher than the renumbered defect. For example,
if the next defect added to the project file would be
numbered 1011 and you renumber a defect to 1200, the next
defect added will be 1201.

Tip
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If you select the entire defect list and renumber it, you may
still need to set the next available defect number to a value
of one greater than the highest defect number in the defect
list. This ensures that new defects continue in the proper
sequence. See “Deferred defect numbering,” earlier in this
chapter, to learn how to set the next available defect
number.
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Working with User Groups

Contents

Safe and Secure!

About user groups and
security
Adding a user group
Viewing a user group
Changing a user group
Deleting a user group

In a multi-user project file, user groups are your
key to security. If security is important to you,
create user groups up front to handle all of your
security levels.
This chapter explains how to add, change, view
and delete user groups. The chapter starts with
an explanation of how user groups affect security
in multi-user project files.

Chapter 5. Working with User Groups

117

About user groups and security
A user group is a collection of users who share
responsibilities and perform similar tasks.
Note

User group security functionality pertains only to multiuser project files.
When you set up a multi-user project file, create the user
groups first. This lets you create a security structure to hold
all of your users.
You can create many kinds of security structures. For
example, you could create the following simple structure
and name the user groups according to their security level:
User Group
Name

Description

Commands Granted

Level 1

Low clearance

View

Level 2

Medium clearance

View & Add

Level 3

High clearance

View, Add, & Edit

Level 4

Highest clearance

View, Add, Edit, &
Delete

Or you can use the same simple structure and name the user
groups according to job description:
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User Group
Name

Description

Commands Granted

Tech Writer

Low clearance

View

Engineer

Medium clearance

View & Add

QA Tester

High clearance

View, Add, & Edit

Manager

Highest clearance

View, Add, Edit, &
Delete
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You can create a simple security structure as shown in this
example, or you can create a complex structure. Whatever
your needs, you may find it helpful to create a matrix listing
the kinds of users you’ll be adding to the project file and
what their needs are. You can add as many or as few user
groups as you need, and make their security levels as
general or as command-specific as you need.
If you want all of your users to have access to all of the
commands, you do not have to create user groups!
TestTrack adds a user group called “Administration”
when you create a multi-user project file. This user group
grants access to every command in TestTrack. Simply add
the users to this default user group.

Tip

Adding a user group
To add a user group:
1

Choose User Group from the Create menu, or click the
Add button on the User Groups list window.
The Add User Group dialog box appears.

When you create a
multi-user project
file...

...TestTrack adds
this user.
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2

Enter a name and description.
You must supply the name and description.

3

On the Users tab, make sure the Include users in pop-up
menus checkbox is selected.

By default, this checkbox is always selected. This checkbox
controls whether users in the group appear in the user list
pop-up menus. If you track lots of names in the user list, the
pop-up menu can become quite long.

The following explains when to check/clear the box:
• Select the checkbox if you are adding a user group intended
for users who participate in the defect life cycle. You want
these users to appear in the user list pop-up menus so you
can assign defects to them, etc.
• Clear the checkbox if you are adding a user group intended
to hold users who only report bugs. This will prevent the
user list pop-up menus from becoming too long by listing all
the users.
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Ä
4

Where to go next...
Skip the rest of the Users tab—it’s best to create the user
group security structure first. You can add users to the
user groups later. However, if you’re adding a user group
to an existing user group structure and the users are
already in the project file, add the users now. See
“Adding users to a user group, “ next, for detailed
instructions.
Click the Security tab, and set the security for each
category in the Category list box.
The following explains:
When you select a category in the Category list box, all the
commands that pertain to the category appear in the
Command list box.

When you select
Defects...

...all the Defect
commands appear
here.
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A check mark beside a command means the user group has
access to that command. To block access to a command,
remove the check mark by clicking on it.

Click on a check
mark to toggle it
off.

Note

Be sure to set the commands for each category in the
Category list box. TestTrack defaults to Enable All
commands in each category.

5

Click the Notes tab, and enter any pertinent information.

6

Choose Add.
The Add User Group dialog box clears and you’re ready to
add another user group. When you’re finished, choose
Cancel.

Tip
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The user group is added to the project file and appears in
the User Groups list window. The user groups are listed in
alphabetical order; don’t forget you can sort on any field—
just click on the column heading. You can also add more
columns or change the sort order. See “Using a list
window,” in Chapter 3, “Working with Project Files,” to
review.
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Adding users to a user group
After you create the user group security structure, it’s time
to add users to the user groups.
Note

If you are adding user groups currently and you are on the
Add User Groups dialog box, skip to step 3.
To add users to a user group:

1

Select the user group you want to add users to from the
User Groups list window.
You may select more than one. To select a range, click at the
start item and shift-click at the end item. To select multiple
items not in a range, command-click each item.

2

Choose Edit User Group from the Edit menu, or click the
Edit button on the User Groups list window.
The Edit User Group dialog box appears.
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3

Select a user from the Available Users list box and click
Add.
The name appears in the Users in Group list box. Repeat this
step for all the users you want to add to the user group.

Select a name in the
list box and click Add.

The name will appear
in this list box.

A user can belong to one user group. When you assign a
user to a new user group, he or she leaves the old group
and joins the new group automatically.

Tip

4

Click Add.
The users are added to the user group.

Viewing a user group
To view a user group:
1

Select the user group you want to view from the User
Groups list window.
You may select more than one. To select a range, click at the
start item and shift-click at the end item. To select multiple
items not in a range, command-click each item.
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If the View button is bold, double-click the user group to
select it and open the View User Group dialog box at the
same time. You can set this preference in the Preferences
dialog box.

Tip

2

Choose View User Groups from the Edit menu, or click the
View button on the User Groups list window.
The View User Group dialog box appears.

Click on a tab to
view its contents.

When viewing or editing a user group, next and previous
arrows appear at the bottom of the dialog box. Click the
arrows to page through the user groups.

Tip

3

Choose OK when you’re finished.
You return to the User Groups list window.
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Changing a user group
To change a user group:
1

Select the user group you want to change from the User
Groups list window.
You may select more than one. To select a range, click at the
start item and shift-click at the end item. To select multiple
items not in a range, command-click each item.
If the Edit button is bold, double-click the user group to
select it and open the Edit User Groups dialog box at the
same time. You can set this preference in the Preferences
dialog box.

Tip

2

Choose Edit User Group from the Edit menu, or click the
Edit button on the User Groups list window.
The Edit User Group dialog box appears.

When viewing or editing a user group, next and previous
arrows appear at the bottom of the dialog box. Click the
arrows to page through the user groups.

Tip

3
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Make any changes.
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4

Choose OK.
You return to the User Groups list window. Your changes
have been made.

Deleting a user group
To delete a user group:
1

Select the user group you want to delete from the User
Groups list window.
You may select more than one. To select a range, click at the
start item and shift-click at the end item. To select multiple
items not in a range, command-click each item.

2

Choose Delete User Group from the Edit menu, or click the
Delete button on the User Groups list window.
The user group is removed from the User Groups list
window.
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Working with Users

Contents

Defect, defect, who has the defect!

About users
Adding a user
Viewing a user
Changing a user
Deleting a user
Making a customer a user

Users, the people who find, fix and verify
defects—who found it, who fixed it, who should
be fixing it? By tracking users, TestTrack
improves communications and accountability in
your QA process.
This chapter explains how to add, change, view
and delete users. The chapter starts with an
explanation of the differences between users in
multi-user and single-user project files.
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About users
A user is anyone who can access TestTrack and is involved
in the testing process. Users are treated differently in singleuser and multi-user project files.

Single-user
project file

Single-user
project file

Multi-user
project file

If you are using a single-user project file, you have access
to every command in TestTrack.
Single-user project files do not have user group security;
however, you are not totally without security. You can
password protect your project file so only you can access it,
or you can give the password to your team members. If
you prefer, you can omit the password so anyone can
access the file.
As a single user, you should add a list of users who will be
reporting, fixing, and verifying bugs. This lets you quickly
pick their names from the pop-up menus when you work
with defects.

Multi-user
project file

If you are using a multi-user project file, you can access
only those commands granted to the user group you
belong to. Unless you are the project administrator or have
been granted high clearance, you probably will not add
users to the project file.
As a user in a multi-user project file, you should set your
own password to protect your security level. If you have a
high security level, a password keeps lower-level users
from using your user name to gain access to higher-level
commands, compromising the security of the project file.
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Adding a user
Note

When you add users to a multi-user project file, you must
place them in a user group. You can add them to the fullsecurity user group “Administration,” which TestTrack
adds automatically when you create a multi-user project
file, or you can add them to user groups you created to
handle your company’s varied security needs. If you want
to use custom user groups, and you have not yet created
them, see “Adding a user group” in Chapter 5, “Working
with User Groups.”
To add a user:

1

Choose User from the Create menu, or click the Add
button on the Users list window.
The Add User dialog box appears.

2

Enter the user information.
You must supply a First Name, Last Name, and User Name.
You do not have to supply a Password; you can let the user
enter his or her own.

Note
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You may want to assign the user a password to protect a
high-security user group. The user can then change the
password when he or she logs on.
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3

Enter the information on the Info tab.
If you are in a multi-user project file, you must select a user
group from the User Group pop-up menu. All other
information is optional.

Note

4

The e-mail group box contains the user’s preferred method
of receiving e-mail and the user’s e-mail address.
TestTrack’s e-mail notifications are sent to this e-mail
address. Make sure you accurately enter this information
to ensure e-mail notifications reach the user.

Enter the information on the Mail tab.

The following describes each option:
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•

Click the Defects are assigned to me check box if you
want to receive e-mail when defects are assigned to you.

•

Click the Any defect changes check box if you want to
receive e-mail whenever a defect is edited.

TestTrack User Manual

5

•

Click the New defects are added check box if you want
to receive e-mail when defects are added to the project
file.

•

Click the Don’t send me mail if I change or add a defect
check box if you don’t want TestTrack to send you email when you are the user who edited or added the
defect.

Enter the information on the CPU tab.
Click Capture Config to have TestTrack fill in a few of the
fields for you. These fields are optional; however, you
should enter as many as possible.

Click here to have
TestTrack gather
information for you.

6

Enter the information on the Peripherals tab.
These fields are optional; however, you should enter as
many as possible.
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7

Note

8

Enter any notes you want to keep track of on the Notes tab.

For future reference, click the Statistics tab. You can not
add anything to this tab, but notice that it contains
statistical information calculated for you. You’ll use this
tab most often when viewing user information. See
“Viewing a user,” next, for details.

Choose Add.
The Add User dialog box clears and you’re ready to add
another user. When you’re finished, choose Cancel.

Tip

134

The user is added to the project file and appears in the
Users list window. The users are listed in alphabetical
order; don’t forget you can sort on any field—just click on
the column heading. You can also add more columns or
change the sort order. See “Using a list window,” in
Chapter 3, “Working with Project Files,” to review.

TestTrack User Manual

Viewing a user
To view a user:
1

Select the user you want to view from the Users list
window.
You may select more than one. To select a range, click at the
start item and shift-click at the end item. To select multiple
items not in a range, command-click each item.
If the View button is bold, double-click the user to select it
and open the View User dialog box at the same time. You
can set this preference in the Preferences dialog box.

Tip

2

Choose View Users from the Edit menu, or click the View
button on the Users list window.
The View User dialog box appears.

Tip
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When viewing or editing a user, next and previous arrows
appear at the bottom of the dialog box. Click the arrows to
page through the users.

135

3

Click the Statistics tab.
You should, of course, view the other tabs too, but always be
sure to view the Statistics tab for the user stats gathered and
calculated for you.

4

Choose OK when you’re finished.
You return to the Users list window.

Changing a user
To change a user:
1

Select the user you want to change from the Users list
window.
You may select more than one. To select a range, click at the
start item and shift-click at the end item. To select multiple
items not in a range, command-click each item.

Tip
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If the Edit button is bold, double-click the user to select it
and open the Edit User dialog box at the same time. You
can set this preference in the Preferences dialog box.
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2

Choose Edit Users from the Edit menu, or click the Edit
button on the Users list window.
The Edit User dialog box appears.

When viewing or editing a user, next and previous arrows
appear at the bottom of the dialog box. Click the arrows to
page through the users.

Tip

3

Make any changes.

4

Choose OK.
You return to the Users list window. Your changes have
been made.

Deleting a user
To delete a user:
1

Select the user you want to delete from the Users list
window.
You may select more than one. To select a range, click at the
start item and shift-click at the end item. To select multiple
items not in a range, command-click each item.
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2

Choose Delete User from the Edit menu, or click the
Delete button on the Users list window.
The user is removed from the Users list window.

Making a customer a user
In the event a user is accidentally added to the customer list
or you want to provide a customer with direct access to your
project file, TestTrack makes it easy to transfer the customer
from the Customer list to the User list.
To make a user a customer:
1

Select the customer you want to convert from the
Customers list window.
You may select more than one. To select a range, click at the
start item and shift-click at the end item. To select multiple
items not in a range, command-click each item.

2

Choose Transfer to User List from the Edit menu.
The customer is removed from the Customers list window
and appears in the User list window. At this point, you
should give the new user a user name and password and set
their user group so they can access the project file.
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Working with Customers

Contents

Customers—your most valuable asset!

About customers
Adding a customer manually
Making a user a customer
Viewing a customer
Changing a customer
Duplicating a customer
Deleting a customer

Customers provide valuable feedback in the
form of bug reports, feature requests, and
questions. TestTrack makes it easy to track
customers and the issues they’ve reported.
This chapter explains how to add, change, view
and delete customers.
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About customers
A customer is anyone who does not participate in the defect
life cycle, but does reports bugs, feature requests or other
issues that you track in your project file. Customers are
typically the end users of your products or services. Unlike
users, customer do not have direct access to the TestTrack
project file.
The following are three ways to add customers to the
database:
Importing a
Solo Bug file

Making a user
a customer

Adding a
customer
manually
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If you import a Solo Bug file from a customer and the
customer does not already exist in the database file,
TestTrack adds the customer for you. .
TestTrack 1.5 and previous versions did not support
customers as their own entity—you simply tracked
customers through the Users list window. TestTrack 1.6
introduced customer support and a Customers list
window. If you have customers entered as users, you can
convert them quickly using the Transfer to Customer List
menu item. See Chapter 6, “Working with Users,” to learn
how to do this.
If a customer does not use Solo Bug to report bugs, you can
add him or her to the database manually just as you would
add a user.
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Adding a customer manually
Have your customers use Solo Bug to report their bugs,
and skip this task! If you import a Solo Bug file and the
customer does not already exist in the database file,
TestTrack adds the customer for you. See Chapter 12
“Working with Solo Bug,” for details.

Tip

To add a customer:
1

Choose Customer from the Create menu, or click the Add
button on the Customers list window.
The Add Customer dialog box appears.

2

Enter the customer information.
You must supply a First Name, Last Name, and Company
Name. You can also mark whether the customer is a Beta
Site.
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3

Enter the information on the Info tab.
All information is optional.

4

Enter the information on the CPU tab.
These fields are optional; however, you should enter as
many as possible.
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5

Enter the information on the Peripherals tab.
These fields are optional; however, you should enter as
many as possible.

6

Note

Enter any notes you want to keep track of on the Notes tab.

For future reference, click the Statistics tab. You can not
add anything to this tab, but notice that it contains
statistical information calculated for you. You’ll use this
tab most often when viewing customer information. See
“Viewing a customer,” next, for details.
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7

Choose Add.
The Add Customer dialog box clears and you’re ready to
add another customer. When you’re finished, choose Cancel.
The customer is added to the project file and appears in the
Customers list window. By default, the customers are
listed in alphabetical order; don’t forget you can sort on
any field—just click on the column heading. You can also
add more columns or change the sort order. See “Using a
list window,” in Chapter 3, “Working with Project Files,”
to review.

Tip

Making a user to a customer
TestTrack 1.5 and previous versions did not support
customers as their own entity—you simply tracked
customers through the Users list window. TestTrack 1.6
introduced customer support and a Customers list window.
If you have customers entered as users, you can convert
them quickly using the Transfer to Customer List menu
item.
To convert a user to a customer: :
1

Select the user you want to transfer to a customer from the
Users list window.
You may select more than one. To select a range, click at the
start item and shift-click at the end item. To select multiple
items not in a range, command-click each item.

2

Choose Transfer to Customer List from the Edit menu.
TestTrack converts the user to a customer. The customer
appears in the Customers list window.

Note
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The Transfer to Customer List menu item is a toggle. When
you are in the Customers list window, the menu item
changes to Transfer to User List. At any time, you can
select a customer and convert it to a user.
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Viewing a customer
To view a customer:
1

Select the customer you want to view from the Customers
list window.
You may select more than one. To select a range, click at the
start item and shift-click at the end item. To select multiple
items not in a range, command-click each item.
If the View button is bold, double-click the customer to
select it and open the View Customer dialog box at the
same time. You can set this option in the Options dialog
box.

Tip

2

Choose View Customer from the Edit menu, or click the
View button on the Customers list window.
The View Customer dialog box appears.

Tip

When viewing or editing a customer, next and previous
arrows appear at the bottom of the dialog box. Click the
arrows to page through the customers.
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3

Click the History tab.
The customer history tab shows all defect reported by the
customer. You can view any defect’s detail information by
double-clicking on it in the list.

4

Click the Statistics tab.
You may, of course, view the other tabs too, but always be
sure to view the Statistics tab for the customer stats gathered
and calculated for you.

5

Choose OK when you’re finished.
You return to the Customers list window.
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Changing a customer
To change a customer:
1

Select the customer you want to change from the
Customers list window.
You may select more than one. To select a range, click at the
start item and shift-click at the end item. To select multiple
items not in a range, command-click each item.
If the Edit button is bold, double-click the customer to
select it and open the Edit Customer dialog box at the same
time. You can set this option in the Options dialog box.

Tip

2

Choose Edit Customer from the Edit menu, or click the
Edit button on the Customers list window.
The Edit Customer dialog box appears.

When viewing or editing a customer, next and previous
arrows appear at the bottom of the dialog box. Click the
arrows to page through the customers.

Tip

3

Make any changes.
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4

Choose OK.
You return to the Customers list window. Your changes have
been made.

Duplicating a customer
To duplicate a customer:
1

Select the customer you want to duplicate from the
Customers list window.
You may select more than one. To select a range, click at the
start item and shift-click at the end item. To select multiple
items not in a range, command-click each item.

2

Choose Duplicate Customer from the Edit menu.
TestTrack duplicates the customer.

Deleting a customer
To delete a customer:
1

Select the customer you want to delete from the Customers
list window.
You may select more than one. To select a range, click at the
start item and shift-click at the end item. To select multiple
items not in a range, command-click each item.

2

Choose Delete Customer from the Edit menu, or click the
Delete button on the Customers list window.
The customer is removed from the Customers list window.
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8

Working with Filters

Contents

Filter Out the Noise!

About filters
Adding a filter
Using a filter
Viewing a filter
Changing a filter
Deleting a filter

Filters let you see only what you want to see.
Once you create a filter, you can use it over and
over to sift and sort your data. Create as many
filters as you need to handle your search
requirements. If you are in a multi-user project
file, you can share your filters with others, or you
can keep them private.
This chapter explains how to add, change, view
and delete filters. The chapter starts with an
explanation of how filters can help you list
specific data and save time.
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About filters
Filters only apply to defects. Filters allow you to selectively
list which defects you see in the Defects list window. The
following shows the Defects list window with no filter
selected:
No filter is selected.

All the defects in
the project file
appear in the list
window.

The following shows the Defects list window with a filter
selected. This filter reduces the list to only those defects that
are feature requests:
A filter is selected.

Only those defects
that are feature
requests appear in
the list window.

Note
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You can also use filters to selectively list defects you want
to appear in reports.

TestTrack User Manual

When you create a filter, you give it a name, which appears
on the Filter pop-up menu. When you want to user the filter,
select it from the pop-up menu.

If you’re working in a multi-user project file, you can choose
to “share” a filter when you create it. Other users can see a
shared filter in their pop-up menu. They can use it and edit
it. If you don’t want to share a filter, you can keep it private.

Adding a filter
To add a filter:
1

Choose Filter from the Create menu, or click the Add
button on the Filters list window, or select New Filter from
the Filter pop-up menu on the Defects list window.
The Add Defect Filter dialog box appears.
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2

Enter a name and description for the filter.
You must supply a name and a description.

Note

If you are working with a multi-user project file, select the
Share check box if you want others to use your filter.
Remember, however, that others will also be able to edit
your filter. If you want your filter protected, do not select
the Share check box.
Select this check
box if you want to
share the filter.

You can share a filter any time. However, once a filter is
marked “shared,” it remains a shared filter—you can’t
make it private again.
3

Select all the fields you want included in the filter from
the Restrict By pop-up menu, and select the restrictions for
each field.
When you select a field from the Restrict By pop-up menu,
the restrictions you can set for the field appear.

152

TestTrack User Manual

When you select
a field here...

...the restrictions
you may set appear
here.

One of four kinds of options appears for each field:
List box

When a List box appears, click on the items you want in
the filter. A check mark appears beside selected items.

The list boxes that display lists of TestTrack users contain
two extra entries at the top of the list: Current User and
Unknown.
Current User represents the current user logged into a
multi-user project file. For example, if you select Current
User with Restrict by set to Assigned To, you are saying
“Show me all defects assigned to me.” If another user logs
in, TestTrack shows the defects assigned to that user.
Unknown represents an empty field. For example, if you
select Unknown with Restrict by set to Assigned To, you
are saying “Show me all defects not assigned to anyone.”
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From/Through
Number boxes

When a From/Through Number box appears, enter a From
and Through number.

From/Through
Date boxes

When a From/Through Date box appears, enter a From
and Through date. Use the following format: mm/dd/yy

From/Through dates specify specific starting and ending
dates. Enter these in mm/dd/yy format or the date format
defined by your configuration.
Fixed Period dates specify a period relative to the current
date. This period can be today, yesterday, last week, last
month, etc. An example is “Restrict by defects fixed this
month.” When you select a variable period, TestTrack
calculates the filter’s date range based on the current date
and displays it for you.
Variable Period dates specify a number of days, weeks,
months, or years relative to the current date. An example is
“Restrict by defects found in the last four weeks.” When
you select a variable period, TestTrack calculates the filter’s
date range based on the current date and displays it for
you.
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Contents box

Option buttons

Note

When a Contents box appears, enter a description. This
field searches for word fragments. What you enter does
not have to match exactly what you entered when you
added the defect.

When option buttons appear, select one. Some option
buttons make a list box appear. See “List box,” above.

You can add as many fields as you wish to the filter. All of
the selected fields appear in the Selected Restrictions note
box.

Look here to see all
the fields you have
set restrictions on.
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4

Choose Add.
The Add Defect Filter dialog box clears and you’re ready to
add the next filter. When you’re finished, choose Cancel.

Tip

The filter is added to the project file and appears in the
Filters list window. The filters are listed in alphabetical
order; don’t forget you can sort on any field—just click on
the column heading. You can also add more columns or
change the sort order. See “Using a list window,” in
Chapter 3, “Working with Project Files,” to review.

Using a filter
Before you can use a filter, you must add it to the project file.
See “Adding a filter,” previous, for instructions.
To use a filter:
Select the filter name from the Filter pop-up menu on the
Defects list window.

All the restrictions defined in the filter are applied to the
defects in the list window.
Note
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Filters only can be used in the Defects list window and
when creating reports.
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Viewing a filter
To view a filter:
1

Open the Filters list window.
All the filters appear in the list window.

2

Select the filter you want to view.
You may select more than one. To select a range, click at the
start item and shift-click at the end item. To select multiple
items not in a range, command-click each item.

Tip
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If the View button is bold, double-click the filter to select
it and open the View Filter dialog box at the same time.
You can set this option in the Preferences dialog box.
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3

Choose View Filter from the Edit menu, or click the View
button on the Filters list window.
The View Defect Filter dialog box appears.

When viewing or editing a filter, next and previous arrows
appear at the bottom of the dialog box. Click the arrows to
page through the filters.

Tip

4

Choose OK when you’re finished.
You return to the Filters list window.
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Changing a filter
To change a filter:
1

Open the Filters list window.
All the filters appear in the list window.

2

Select the filter you want to edit.
You may select more than one. To select a range, click at the
start item and shift-click at the end item. To select multiple
items not in a range, command-click each item.

Note

Chapter 8. Working with Filters

If the Edit button is bold, double-click the filter to select it
and open the Edit Filter dialog box at the same time. You
can set this option in the Preferences dialog box.
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3

Choose Edit Filter from the Edit menu, or click the Edit
button on the Filters list window.
The Edit Defect Filter dialog box appears.

When viewing or editing a filter, next and previous arrows
appear at the bottom of the dialog box. Click the arrows to
page through the filters.

Tip

4

Make any changes.

5

Choose OK.
You return to the Filters list window. Your changes have
been made.
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Deleting a filter
To delete a filter:
1

Open the Filters list window.

2

Select the filter you want to delete from the Filters list
window.
You may select more than one. To select a range, click at the
start item and shift-click at the end item. To select multiple
items not in a range, command-click each item.

3

Choose Delete Filter from the Edit menu, or click the
Delete button on the Filters list window.
The filter is removed from the Filters list window.
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9

Working with Test
Configurations

Contents

Track the Nuts and Bolts!

About test configurations
Adding a test configuration
Viewing a test configuration
Changing a test configuration
Deleting a test configuration

It’s important to pay attention to the machines
defects are found on. A serious bug may be
lurking on a specific test configuration. Is this a
hardware problem, low-memory situation,
display driver bug? Track your test
configurations and identify the patterns.
This chapter explains how to add, change, view
and delete test configurations. The chapter starts
with an explanation of why tracking test
configurations is important.
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About test configurations
A test configuration simply refers to a specific computer
used for testing. You may want to keep track of all your
systems to see if bugs are computer-specific. Tracking test
configurations helps you identify patterns in defects that
may be related to specific hardware configurations or
software configurations.

Adding a test configuration
To add a test configuration:
1

Choose Test Config from the Create menu, or click the
Add button on the Test Configurations list window.
The Add Test Config dialog box appears.

2

Type a name for the test configuration.
This name should uniquely identify a single computer. For
example, Eng-cube1.

3

Enter the information on the CPU tab.
Be sure to click Capture Config to have TestTrack fill in a
few fields for you. These fields are optional; however, you
should enter as many as possible.
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Click here to have
TestTrack capture
a few fields.

4

Click the Peripherals tab, and enter the information.
These fields are optional; however, you should enter as
many as possible.

5

Choose Add.
The Add Test Config dialog box clears and you’re ready to
add the next test configuration. When you’re finished,
choose Close.
The test configuration is added to the project file and
appears in the Test Configurations list window. The test
configs are listed in alphabetical order; don’t forget you
can sort on any field—just click on the column heading.
You can also add more columns or change the sort order.
See “Using a list window,” in Chapter 3, “Working with
Project Files,” to review.

Tip

Viewing a test configuration
To view a test configuration:
1

Select the test configuration you want to view from the
Test Configurations list window.
You may select more than one. To select a range, click at the
start item and shift-click at the end item. To select multiple
items not in a range, command-click each item.
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If the View button is bold, double-click the test
configuration to select it and open the View Test Config
dialog box at the same time. You can set this preference in
the Preferences dialog box.

Tip

2

Choose View Test Config from the Edit menu, or click the
View button on the Test Configurations list window.
The View Test Config dialog box appears.

When viewing or editing a test configuration, next and
previous arrows appear at the bottom of the dialog box.
Click the arrows to page through the test configurations.

Tip

3

Choose OK when you’re finished.
You return to the Test Configurations list window.
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Changing a test configuration
To change a test configuration:
1

Select the test configuration you want to change from the
Test Configurations list window.
You may select more than one. To select a range, click at the
start item and shift-click at the end item. To select multiple
items not in a range, command-click each item.
If the Edit button is bold, double-click the user to select it
and open the Edit Test Config dialog box at the same time.
You can set this preference in the Preferences dialog box.

Tip

2

Choose Edit Test Configs from the Edit menu, or click the
Edit button on the Test Configurations list window.
The Edit Test Config dialog box appears. Be sure to click
Capture Config to have TestTrack update a few fields for
you.

Click here to have
TestTrack gather
information for you.

When viewing or editing a test configuration, next and
previous arrows appear at the bottom of the dialog box.
Click the arrows to page through the test configurations.

Tip

3

Make any changes.
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4

Choose OK.
You return to the Test Configurations list window. Your
changes have been made.

Deleting a test configuration
To delete a test configuration:
1

Select the test configuration you want to delete from the
Test Configurations list window.
You may select more than one. To select a range, click at the
start item and shift-click at the end item. To select multiple
items not in a range, command-click each item.

2

Choose Delete Test Config from the Edit menu, or click the
Delete button on the Test Configurations list window.
The test configuration is removed from the list window.
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10

Working with Reports

Contents

Analyze and Report!

About reports
Adding a detail report
Adding a distribution report
Adding a list report
Adding a trend report
Viewing a report
Changing a report
Deleting a report
Previewing a report
Printing a report
Generating Release Notes

TestTrack makes reporting simple—point,
click, print, and read. You can design each
report and preview it before you print it. If
you are in a multi-user project file, you can
share your report with others, or you can keep
it private.

Chapter 10. Working with Reports

This chapter explains how to add, change,
view delete, preview and print reports. The
chapter starts with an explanation of the kinds
of reports you can create.
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About reports
Reports let you analyze the data you’ve entered in your
project file. You can use the filters you’ve already created to
focus the report on data important to you. If you’re working
in a multi-user project file, you can share your reports with
others, or you keep them private. You can create the
following four kinds of reports:
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Detail report

A detail report prints all the information about the items of
interest. This could be a defect, user, user group, or test
configuration. You control which items TestTrack reports
on. The following is a sample detail report:

Distribution
report

A distribution report prints the distribution of defects by
user or test configuration. For example, for each user, show
the defects assigned by priority or show the number of
defects fixed. The following is a sample distribution report:
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List report

Trend report

A list report prints summary information about an item
(defect, user, user group, or test configuration). You select
the fields to include and their order in the report. This lets
you see only the information important to you. The
following is a sample list report:

A trend report prints defect events over time. For example,
how many defects have been fixed this week? You can use
this report to determine how well you are keeping up with
the flow of defects—are you winning the war or losing it?
The following is a sample trend report:
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Adding a detail report
To add a detail report:
1

Choose Detail from Report on the Create menu.
The Add Detail Report dialog box appears.

Note

You may also click the Add button on the Reports window.
The Create Report dialog box appears.

Choose Detail from the pop-up menu and click OK. The
Add Detail Report dialog box appears.
2

Enter a Name and Title for the report.
The Title appears on the report.
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Note

3

If you are in a multi-user project file, select the Share
check box if you want to share this report with others. If
you want this report to remain private, do not select the
check box. Shared reports appear in other users’ Reports
list window—private reports do not.
Select what you want to report on from the Report
Contains pop-up menu.

The following explains your choices:
Defects

Users
User Groups
Customers
Test Configs

If you select Defects, you may also select a filter from the
Filter pop-up menu.

If you choose Users, User Groups, Customers, or Test
Configs, radio buttons appear:
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Choose All Users to report on all the users in the project
file. Choose Selected Users to select specific users. When
you choose Selected Users, a list box appears.

Select those users you want in the report. A check mark
appears beside the name. To deselect a user, click on the
check mark (it toggles off).

Note

4

Choose the Insert Page Break check box if you want page
breaks between each item in the report.
Choose Add.
The dialog box clears and you’re ready to add another
report. If you’re finished, choose Cancel.
The report appears in the Reports window. From the Reports
window you can preview or print the report. See
“Previewing a report” or “Printing a report,” later in this
chapter, for instructions.
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Adding a distribution report
To add a distribution report:
1

Choose Distribution from Report on the Create menu.
The Add Distribution Report dialog box appears.

Note

You may also click the Add button on the Reports window.
The Create Report dialog box appears.

Choose Distribution from the pop-up menu and click OK.
The Add Distribution Report dialog box appears.
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2

Enter a Name and Title for the report.
The Title appears on the report.

Note

3

If you are in a multi-user project file, select the Share
check box if you want to share this report with others. If
you want this report to remain private, do not select the
check box. Shared reports appear in other users’ Reports
list window—private reports do not.
Select a option button in the Report On group box.
Be sure to select an item from the pop-up menu.

4

Enter the dates you want to report on in the Options group
box.
Use the following format to enter a date: mm/dd/yy

Note

5

Also select the check box if you want to include totals.
Choose Add.
The dialog box clears and you’re ready to add another
report. If you’re finished, choose Close.
The report appears in the Reports window. From the Reports
window you can preview or print the report. See
“Previewing a report” or “Printing a report,” later in this
chapter, for instructions.
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Adding a list report
To add a list report:
1

Choose List from Report on the Create menu.
The Add List Report dialog box appears.

Note

You may also click the Add button on the Reports window.
The Create Report dialog box appears.

Choose List from the pop-up menu and click OK. The Add
List Report dialog box appears.
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2

Enter a Name and Title for the report.
The Title appears on the report.

Note

3

If you are in a multi-user project file, select the Share
check box if you want to share this report with others. If
you want this report to remain private, do not select the
check box. Shared reports appear in other users’ Reports
list window—private reports do not.
Select what you want to report on from the Report
Contains pop-up menu.
If you select Defects, you may also select a filter from the
Filter pop-up menu.

4

Select a field you want in the report from the Available
Fields list box, and click the >> Add >> button.
The field appears in the Fields in Report list box. You may
add as many fields as you wish.
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Note

The order the fields appear in the Fields in Report list box,
is the order they appear in the report. TestTrack sorts by
the first field in the list.

If you need to move a field to a new position in the list:
select the name and click the Up or Down button. If you
need to remove a field from the list: select the field and
click the Remove button.
5

Select the Print grid lines check box if you want grid lines
in your report.

6

Choose Add.
The dialog box clears and you’re ready to add another
report. When you’re finished, choose Cancel.
The report appears in the Reports window. From the Reports
window you can preview or print the report. See
“Previewing a report” or “Printing a report,” later in this
chapter, for instructions.
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Adding a trend report
To add a trend report:
1

Choose Trend from Report on the Create menu.
The Add Trend Report dialog box appears.

Note

You may also click the Add button on the Reports window.
The Create Report dialog box appears.

Choose Trend from the pop-up menu and click OK. The
Add Trend Report dialog box appears.
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2

Enter a Name and Title for the report.
The Title appears on the report.

Note

3

If you are in a multi-user project file, select the Share
check box if you want to share this report with others. If
you want this report to remain private, do not select the
check box. Shared reports appear in other users’ Reports
list window—private reports do not.
Select a radio button in the Report On group box.
The following explains your choices:

Defect status
in period

Select this radio button to report the number of defects in
each state (Open, Fixed, etc.) over the specified reporting
period.

Defects...by...

Select this radio button to report on the number of defects
that are Open, Fixed, Closed, etc. by their Type, Priority, or
Resolution. Be sure to select an item from each pop-up
menu.

4

Enter the dates you want to report on in the Options group
box.
Select the period from the pop-up menu. Use the following
format to enter a date: mm/dd/yy

Note

Select the Include Totals check box if you want the report
to include totals.
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5

Choose Add.
The dialog box clears and you’re ready to add another
report. When you’re finished, choose Cancel.
The report appears in the Reports window. From the Reports
window you can preview or print the report. See
“Previewing a report” or “Printing a report,” later in this
chapter, for instructions.

Viewing a report’s settings
To view report settings:
1

Select the report from the Reports window.
To select a range of reports, click the first item in the range,
then shift-click the last item. To select multiple reports not
in a range, command-click each report.
If the View button is bold, double-click the report to select
it and open the View Report dialog box at the same time.
You can set this preference in the Preferences dialog box.

Tip

2

Choose View.
The View Report dialog box appears. When you’re finished,
choose OK.
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Note

When viewing a report, next and previous arrows appear
at the bottom of the dialog box. Click the arrows to page
through the reports.

Changing a report
To change a report:
1

Select the report from the Reports window.
To select a range of reports, click the first item in the range,
then shift-click the last item. To select multiple reports not
in a range, command-click each report.
If the Edit button is bold, double-click the report to select
it and open the Edit Report dialog box at the same time.
You can set this preference in the Preferences dialog box.

Tip

2

Choose Edit.
The Edit Report dialog box appears.
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3
Note

4

Make any changes.
When editing a report, next and previous arrows appear at
the bottom of the dialog box. Click the arrows to page
through the reports.
Choose OK.
The dialog box closes.

Deleting a report
To delete a report:
1

Select the report from the Reports window.
To select a range of reports, click the first item in the range,
then shift-click the last item. To select multiple reports not
in a range, command-click each report.

2

Choose Delete.
The Report is deleted.

Previewing a report
To preview a report:
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1

Select the report from the Reports list window.

2

Choose Preview.

Click the Preview
button.
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The report appears. To page through the report, click the
Next and Previous arrow buttons or use the scroll bar.

Click the arrows to
page through the
report.

Note

3

You can set the font used in the reports in the Preferences
dialog box. See “Setting preferences” in Chapter 3,
“Working with Project Files,” for instructions.
Choose Print or Page Setup.
The following explains your choices:

Print

Page Setup

To print the report, click the Print button. The Printer
dialog box appears. Make your selections and choose
Print again.
To change the page setup, click the Page Setup button. The
Setup dialog box appears. Make any changes and choose
OK.
When you’re satisfied with the preview, click Print. The
Printer dialog box appears. Choose your settings and click
Print again.

Save As

To save the report as a text file, click the Save As button.
The Save Report As dialog box appears. TestTrack assigns
the title of the report as the file name, you can accept this
name or type a new name. Click Save.
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Printing a report
To print a report:
1

Select the report from the Reports list window.

2

Choose Print.

Click the Print
button.

The Printer dialog box appears.
3

Make your selections and choose Print.
The report prints.

Note

You can set the font used in the reports in the Preferences
dialog box. See “Setting preferences” in Chapter 3,
“Working with Project Files,” for instructions.

Generating release notes
TestTrack lets you generate a text file containing all the
release notes you’ve entered for any of the defects. You may
want to include the text file in a read-me file for a particular
release of your software, or load it into a desktop publisher
and create a formatted document.
Before you can generate a text file containing your release
notes, you must add them to the defects they affect. See
“Adding release notes to a defect,” in Chapter 4, “Working
with Defects,” for instructions.

186

TestTrack User Manual

Note

If you want to generate release notes for just a few defects,
select those defects from the Defects list window now. If
you’re unsure which defects contain release notes, make a
column in the Defects list window to display the Release
Notes? Field. Any defect containing release notes will have
a “Yes” in the column. Those that do not will have a “No.”

To generate release notes:
1

Choose Create Release Notes from the Activities menu.
The Create Release Notes dialog box appears.
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2

Fill in the fields in the Released Versions to Include group
box.
The following explains the fields:

From Version

Enter the first version you want included in the release
notes.

Through Version

Enter the last version you want included in the release
notes. If the release notes are specific to one version, enter
the same version number in both of these fields.

Use Filter

Select a filter from the pop-up menu, or leave the field
blank if you want release notes pulled from all the defects.

Limit to Product

Select a product name from the pop-up menu, or leave the
field blank if you want release notes pulled from the
defects in all the products.

Selected Defects
check box

Select this check box if you want to pull release notes only
from those defects you selected in the Defects list window.

3

Fill in the fields in the Presentation Options group box.

Sort By
check box

Select this check box if you want TestTrack to output the
versions from newest to oldest.

Blank Line
check box

Select this check box if you want TestTrack to insert a blank
line between each release note.
If you’re going to keep this file as a simple text file,
inserting a blank line will enhance readability; but if you’re
going to load this text file into a desktop publishing
program, it’s best not to insert the blank line.

Bullet Style
check box
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Enter the character and any spaces or tabs you want placed
in front of each release note (e.g., a bullet “Ÿ”). You can also
enter ASCII characters or leave the box blank.
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4

Click Preview.
It’s always a good idea to preview the release notes, because
you can edit them in the preview window before saving
them; but if you don’t want to preview, click Create and
Save and skip to step 6.

5

Click Save As.
The Save Release Notes As dialog box appears.
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6

Type a name and check the directory.
By default, the file TestTrack generates is a text file. If you
have XTND translators installed, you can select an
alternative file format.

7

Click Save.
TestTrack generates the release notes and places the file in
the directory you specified.
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Working with the Workbook

Contents

So much To Do!

About the Workbook
Adding a To Do task
Viewing a To Do task
Changing a To Do task
Deleting a To Do task

So little time to do it? Not when you use
TestTrack to help you keep track of the loose
ends and organize other project-related tasks.
This chapter explains how to add, change,
view and delete To Do tasks. The chapter
starts with an explanation of the Workbook
and what a To Do task is.
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About the Workbook
The TestTrack Workbook is a catch all to help you keep track
of those defects assigned to you, loose ends, and things that
are not really bugs, but which are important to you and still
need to be tracked.
The Workbook
keeps track of
bugs assigned to
you...

…and To Do tasks
you add yourself.

Understanding Workbook tasks
TestTrack keeps track of two kinds of tasks in the Workbook
list window:
Defects tasks

To Do tasks
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Those defects assigned to you. TestTrack adds these
tasks automatically to the list from the Defects lists
window.
Those project-related tasks or loose ends you add to the
list.
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Looking at the task indicators
Task indicators appear in the first column of the Workbook
list window. They point out your assigned defects, closed
defects, and To Do tasks you’ve added to the list. The
following shows a sample of each indicator:
The Defect indicator points out any defects assigned to
you.
The Closed Defect indicator points out any of your closed
defects or completed tasks.
The To Do task indicator points out any tasks you have
added to the list.

Note

Notice that the closed task has a red line drawn through it.
You can set this option in the Preferences dialog box. This
is the same option used for a defect. See “Setting
preferences” in Chapter 3, “Working with Project Files.”

The closed defect has a
red line drawn through it.
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Adding a To Do task
To add a To Do task:
1

Choose To Do from the Create menu, or click the Add
button on the Workbook list window.
The Add To Do dialog box appears.

2

Enter the To Do task.
Make this a brief description. You can add a detailed
description in the Description box below.

3

Select the task’s priority from the Priority pop-up menu
(optional step).
TestTrack comes with default values. You may use these, or
you may customize them. These are the same values you
used for a defect. See “Configuring field values” in Chapter
3, “Working with Project Files,” if you want to change or add
values.

4

Check the date (optional step).
Today’s date appears automatically in this field. You may
enter a different date now it you want.
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5

Enter either the date or the version you need the task
completed by (optional step).

6

Enter a detailed description of the task (optional step).

7

Choose Add.
The Add To Do dialog box clears and you’re ready to add
the next task. When you’re finished, choose Close.
The task appears in the Workbook list window. The tasks
are sorted by field; you can sort on any field—just click on
the column heading. You can also add more columns or
change the sort order. See “Using a list window,” in
Chapter 3, “Working with Project Files,” to review.

Tip

Viewing a To Do task
To view a To Do task:
1

Open the Workbook list window.
All the tasks appear in the list window.
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2

Select the task you want to view.
You may select more than one. To select a range, click at the
start item and shift-click at the end item. To select multiple
items not in a range, command-click each item.
If the View button is bold, double-click the task to select it
and open the View To Do dialog box at the same time. You
can set this option in the Preferences dialog box.

Tip

3

Choose View Task from the Edit menu, or click the View
button on the Workbook list window.
The View To Do dialog box appears.

When viewing or editing tasks, next and previous arrows
appear at the bottom of the dialog box. Click the arrows to
page through the tasks.

Tip

4

Choose OK when you’re finished.
You return to the Workbook list window.
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Changing a To Do task
To change a To Do task:
1

Open the Workbook list window.
All the tasks appear in the list window.

2

Select the task you want to change.
You may select more than one. To select a range, click at the
start item and shift-click at the end item. To select multiple
items not in a range, command-click each item.

Note

3

If the Edit button is bold, double-click the task to select it
and open the Edit To Do dialog box at the same time. You
can set this option in the Preferences dialog box.
Choose Edit Task from the Edit menu, or click the Edit
button on the Workbook list window.
The Edit To Do dialog box appears.
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When viewing or editing tasks, next and previous arrows
appear at the bottom of the dialog box. Click the arrows to
page through the tasks.

Tip

4

Make any changes.

5

Choose OK.
You return to the Workbook list window. Your changes have
been made.

Deleting a To Do task
To delete a To Do task:
1

Open the Workbook list window.

2

Select the To Do task you want to delete from the
Workbook list window.
You may select more than one. To select a range, click at the
start item and shift-click at the end item. To select multiple
items not in a range, command-click each item.
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Note

3

You only may delete To Do tasks you have added to the
list. You cannot delete bugs assigned to you.
Choose Delete Task from the Edit menu, or click the
Delete button on the Workbook list window.
A message appears asking you to confirm the deletion.

4

Choose OK.
The To Do task is removed from the Workbook list window.
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Working with Solo Bug

Contents

There must be a better way!

About Solo Bug
Customizing the Solo Bug
executable
Loading Solo Bug files
manually
Activating the Solo Bug file
auto-load feature
Loading Solo Bug files
automatically
Customizing the Solo Bug
user’s guide

How many times have you thought this when
trying to decipher a hand-written bug report
or voice mail message from a customer. Well,
now there is! Solo Bug relieves you of this
tedious task and the hassle of data entry by
allowing you to import bug reports sent to
you by your customers.

Chapter 12. Working with Solo Bug

This chapter explains how to customize the
Solo Bug application for distribution and load
a Solo Bug file manually and automatically.

201

About Solo Bug
Solo Bug is a stand-alone bug reporter that dramatically
simplifies the way you receive bug reports from your
customers.
Solo Bug:
• simplifies bug reporting for your customers
• eliminates data entry of bug reports from your customers
• allows your customers to include file attachments with their
bug reports
• allows you to limit customers to your bug reporting
terminology
• captures your customers’ personal information and
computer information

How do I distribute Solo Bug?
You may distribute Solo Bug 1.1 to all of your customers and
beta sites. Refer to the Solo Bug license included with
TestTrack 1.6 for rules governing distribution of Solo Bug
applications. Solo Bug is available for Macintosh, Windows
3.1, and Windows 95/NT.
Solo Bug comes with a small user’s guide you may edit,
print, copy, and distribute with Solo Bug. Solo Bug for
Macintosh implements balloon help so it is not essential to
distribute a manual with it. Every topic in the guide also
appears in the online Help for the Windows version, so it is
not imperative to distribute the hard copy with Solo Bug for
Windows. You may however, want to customize the guide to
include your company’s name, e-mail destinations, URLs,
etc.
Before you distribute Solo Bug to your customers and beta
sites, you should customize the field values to match your
bug reporting terminology. See “Customizing the Solo Bug
application” for instructions.
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What is a Solo Bug file?
A Solo Bug file contains a single bug report (or feature
request) created by your customers and beta sites in the Solo
Bug application. Your customers simply e-mail the file to
you, which you can then import into any TestTrack project
file. A Solo Bug file contains:
Your customer’s personal
information and computer setup
A description of the problem or
feature request
Any additional data or files
attached to the report

How do I import a Solo Bug file?
You can import Solo Bug files two ways:
• Load the files manually into TestTrack by either selecting
them from a dialog box, or by simply “dragging and
dropping” them on the Defects list window. See “Loading a
Solo Bug file manually” for instructions.
• Activate the auto-load feature and have TestTrack import
the files automatically at regularly defined intervals. See
“Activating the Solo Bug file auto-load feature” for
instructions

Customizing the Solo Bug application
Before you distribute Solo Bug to your customers, you
should customize the field values to match your bug
reporting terminology.
Note

During customization, TestTrack modifies the Solo Bug
application; therefore, before you customize Solo Bug, you
should make a backup of the original.
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To customize the Solo Bug application:
1

Start TestTrack and select the project file you want Solo
Bug to match.
You can pull all the field values from the project file and
save time entering them yourself.

2

Choose Customize Solo Bug from Configure on the
Activities menu.
The Customize Solo Bug dialog box appears.

3

Click Set File.
The Open Solo Bug Application dialog box appears.
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4

Select a Solo Bug executable.
You may choose from any of the following:

Solo Bug

Select this executable if you’re customizing an executable
to run on a Macintosh.

solobug.exe

Select this executable if you’re customizing an executable
to run under Windows 95/NT.

solow31.exe

Select this executable if you’re customizing an executable
to run under Windows 3.1

5

Click Open.
You return to the Customize Solo Bug dialog box. All the
controls are now enabled.

6

Select a field from the What to customize list box.
The default field values appear in the Names list box.

7

Customize the field values for the selected field.
You can add, edit, or delete any field value. To change the
order the field values are listed in: click on the arrow beside
the field value and drag it to a new position.

Drag the double arrows
to reorder the field
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8

Select the remaining options for the selected field.
The following explains the options:

Use Project’s
Names
User can enter
custom types

Click this button to use all the field values in the current
project file.
Check this box to if you want the customer to be able to
enter his or her own field values for the selected field. This
option is most advantageous for the Version and Product
fields. Notice that this option is selected for these fields in
the default Solo Bug executable.

9

Repeat steps 6, 7 and 8 for all the fields in the What to
customize list box.

10

Click Update Solo Bug & Close.
TestTrack modifies the Solo Bug executable. The following
message appears:

11

Click OK.
You are now ready to distribute your Solo Bug executable to
your customers. Solo Bug comes with online Help plus a
user’s quick start guide you can print and distribute also.
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Loading Solo Bug files manually
To load Solo Bug files manually:
1

Choose Load Solo Bug Files from Import on the File menu.
The Solo Bug Files to Import dialog box appears.

Select a file to
import here, then
click Add to add it to
the list below.

This list box lists
which files will be
imported when you
click Done.

2

Click Show All Files if you want to see Solo Bug files
whose Type and Creator are not set properly.

3

Add the Solo Bug files you want to import to the Select
Files to Import list box.

4

Click Done.
The defect report appears in the Defects list window at the
end of the list. Notice the new defect icon appears beside it.

This is the new
defect.
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As a shortcut, to bypass the menu selection and the dialog
box, simply “drag and drop” the Solo Bug file on the
Defects list window.

Tip

Notice that when you drag a file from a folder to the
Defects list window, the cursor becomes a plus sign.

Activating the Solo Bug file auto-load feature
To set up the auto-load feature to have TestTrack import
Solo Bug files automatically at regularly defined intervals:
1

Choose Preferences from the Edit menu.
The Preferences dialog box appears.
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2

Click the Solo Bug tab.

3

Select the interval you want TestTrack to look for new
Solo Bug files from the “Look for new files every” pop-up
menu.
Selecting a frequent update interval will not inhibit
TestTrack performance.

Note

4

If you select a long interval between updates, you can
always override it and update your Defects list window
immediately by choosing Auto Load Solo Bug Files from
Import on the File menu.
Select the directory you want TestTrack to look in for the
Solo Bug files.
You may keep the default directory, which is the directory
TestTrack is running in, or select a new one.
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To select a new directory:

Note

5

1.

Click Set. The Choose Directory dialog box appears.

2.

Select the desired directory and click the Select button.
You return to the Solo Bug tab.

You may want TestTrack to monitor you e-mail
attachments directory.
Select what to do with the files after they’ve been
imported from the After Importing pop-up menu.
The following explains the preference:

Leave files
in directory

After importing, this preference tells TestTrack to leave the
Solo Bug files in the directory. Even though the files remain
in the directory, they are only imported once.

Move files
to another
directory

After importing, this preference tells TestTrack to move the
Solo Bog files to another directory. You specify the
directory in the next step.

Delete files
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After importing, this preference tells TestTrack to delete
the Solo Bug files.
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6

If you selected “Move files to another directory,” select
that directory now.
To select a new directory:
1.

Click Set. The Choose Directory dialog box appears.

2.

Select the desired directory and click the Select button.
You return to the Solo Bug tab.

Loading Solo Bug files automatically
To load Solo Bug files automatically, you must set up the
auto-load feature in the Preferences dialog box. See
“Activating the Solo Bug file auto-load feature,” previous, if
you have not done so already.
When you set up the auto-load feature, you select the
interval you want TestTrack to look for new Solo Bug files;
however, you can override this update interval at any time.
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To override the update interval and load any new Solo Bug
files immediately:
Choose Auto Load Solo Bug Files from Import on the File
menu.

The defect report appears in the Defects list window at the
end of the list. Notice the new defect icon appears beside it.

Customizing the Solo Bug user’s guide
Solo Bug comes with a small user’s guide you may edit,
print, copy, and distribute with Solo Bug. Every topic in the
guide appears in the online Help, so it is not imperative to
distribute the hard copy with Solo Bug. You may however,
want to customize the guide to include your company’s
name, e-mail destinations, URLs, etc.
Note

Before you customize the Solo Bug user’s guide, you may
want to make a backup of the original.
The following explains the Solo Bug user’s guide files:
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solobug.doc

The Solo Bug user’s guide in in Word 6.0 format. The file is
located in the TestTrack folder.

solobug.pdf

The Solo Bug user’s guide in Adobe Acrobat format. The
file is located in the TestTrack folder.

solobug.hlp

The Solo Bug online help for Windows. You cannot
customize the online help that comes with Solo Bug.
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Working with E-mail
Notifications

Contents

E-mail notifications keep you up to date!

About e-mail notifications
Configuring e-mail
notifications
Configuring e-mail message
templates
Sending e-mail manually
Sending e-mail in the
background
Pausing e-mail notifications

Now you can keep track of changed and new bugs
through e-mail. If something new is assigned to
you or a bug changes, you know right away.
This chapter explains how to set up e-mail
notifications to best meet your needs.
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About e-mail notifications
TestTrack lets you send and receive e-mail notifications via
the Simple Mail Transport Protocol (SMTP) e-mail system.
You can set up TestTrack to automatically notify you when:
• a defect is assigned to you
• a defect is added to the database
• a defect changes
In addition, each defect has a Notify tab that lets you add the
users and customers who should receive e-mail notifications
whenever that defect changes. TestTrack also has Send Mail
and Reply to Submitter commands that let you send freeform e-mail to one or more users or customers.
TestTrack queues mail to send and will either send it right
away when you close a defect window or send it in the
background. When TestTrack is sending e-mail in the
background, a small envelop appears to the right of the
process icon on the menu bar.
If for some reason some mail has not been sent when you
close the project file, TestTrack saves the mail queues to your
hard disk drive. The next time you start TestTrack, it reloads the mail queues and continues sending the mail.
Finally, TestTrack allows you to customize the contents of
each type of e-mail notification message and comes with
e-mail message templates.
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Configuring e-mail notifications
Setting up e-mail notifications in TestTrack is easy. First
configure the Send Mail options, then make sure each user
who wants to receive e-mail notifications has a valid e-mail
address specified in his or her user account.

Setting Send Mail options
To access the Options dialog box and complete the Send
Mail tab:
1.

Choose Options from the Edit menu.
The Options dialog box appears.

2

Click the Send Mail tab and select the e-mail options.

The following describes the options:
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Send SMTP mail

Return address
for single-user
project files

Send mail in
background
Prompt to save
mail queues

3

Click the check box if you want to enable sending e-mail
via Simple Mail Transport Protocol (SMTP). SMTP is the
standard used to send e-mail over the Internet. Enter the
SMTP host address.
Enter an e-mail address to use as your return address when
sending e-mail from single-user project files. When sending
e-mail from multi-user project files, the e-mail address
defined in your user account is used.
Click the check box if you want all of your e-mail sent in
the background.
Click the check box if you want TestTrack to prompt you to
save any e-mail not sent when you close a project file. The
mail is sent the next time you start TestTrack

Click OK.
Your new options take effect.

Verifying user notification settings
Each user can determine the types of events that result in email being sent to them. You can set these options on the
User tab of the Options dialog box or the Mail tab on the
Add/Edit user dialog.
To verify each user’s notification settings are set properly:
1

Select the user you want to verify from the Users list
window.
You may select more than one. To select a range, click at the
start item and shift-click at the end item. To select multiple
items not in a range, command-click each item.
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2

Choose Edit Users from the Edit menu, or click the Edit
button on the Users list window.
The Edit User dialog box appears.

When editing a user, next and previous arrows appear at
the bottom of the dialog box. Click the arrows to page
through the users.

Tip

3

Review the Info tab.
Verify the e-mail type field is set to the e-mail system
through which the user will receive notifications and the email address field contains the user’s e-mail address.

4

Click the Mail tab.
Verify the various options are set up per the user’s
preferences.
•

Click the Defects are assigned to me check box if the
user wants to receive e-mail when defects are assigned
to her/him.

•

Click the Any defect changes check box if the user
wants to receive e-mail whenever a defect is edited.
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5

•

Click the New defects are added check box if the user
wants to receive e-mail when defects are added to the
project file.

•

Click the Don’t send me mail if I change or add a defect
check box if the user doesn’t want to receive e-mail
when it was that user who edited or added the defect.

Choose OK.
You return to the Users list window. Your changes have
been made.

Configuring e-mail message templates
TestTrack comes with four generic e-mail notification
message templates which you can modify. E-mail message
templates support field codes, sequences of characters that
are replaced with TestTrack information when the e-mail
message is sent.
To configure e-mail message templates:
1

Choose E-Mail Message Templates from Configure on the
Activities menu.
The Edit E-Mail Templates dialog box appears.
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2

Select an e-mail template to edit.
The following describes each template:

E-Mail
Acknowledgment

Defect
Assignment

When a defect report is received via e-mail, this message is
e-mailed back to the submitter to acknowledge the receipt
of the defect.
When a defect is assigned to a user, this message is emailed to the user.

Defect
Changed

When a defect changes, this message is e-mailed to users
who have requested defect change notifications.

Defect
Added

When a defect is added, this message is e-mailed to users
who have requested defect addition notification.

3

Choose Edit.
The e-mail template dialog box appears.
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4

Edit the subject and message body fields.
Enter a generic message you want to send to each user who
receives e-mail notifications. Use field codes to create
messages that are personalized by TestTrack before they are
e-mailed. The subject and message body fields support field
codes.
About Field Codes
E-mail templates support fields codes, sequences of
letters enclosed in percent signs, that TestTrack replaces
with information from the project file. For example, the
sequence %DATS% is replaced with the current date in
mm/dd/yy format, while the sequence %DNUM% is
replaced with a defect number.
Each e-mail notification corresponds to a single defect.
You use field codes to build personalized e-mail
messages the provide information specific to the defect
that triggered the notification.
See Appendix A, “Field Codes,” for a complete list of
field codes supported by TestTrack.

5

Choose OK.
The e-mail template is saved and the dialog box disappears.
You return to the list of e-mail templates.

6
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Choose Done.
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Sending e-mail in the background
TestTrack can send e-mail either immediately or in the
background. You control this feature in the Send Mail tab of
the Options dialog box. When e-mail is sent immediately,
you must wait for the mail to be sent before you can
continue using TestTrack. When e-mail is sent in the
background, you regain control immediately and can
continue using TestTrack while the e-mail is while you work.
TestTrack displays an envelop icon to the right of the process
icon on the menu bar while mail is being sent. .

Sending e-mail manually
TestTrack has two commands with which you can send email to user and customers: Send Mail and Reply to
Submitter. .

Sending mail to any user or customer
To send an e-mail message manually to one or more users
and customers:
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1

Choose Send Mail from the Mail menu.
The Send Mail dialog box appears.

2

Click the Add button.
The Add Mail Recipients dialog box appears.

3

222

Click the Users and/or Customers check boxes to control
who appears in the list.
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4

Select a name and click Add.
The name appears in the To list box on the Send Mail dialog
box. Repeat for each user and customer you want to send
mail to. Click Cancel when you’ve added all the recipients.

Note

If you want to remove a recipient from the To list box,
select the name and click Remove.

5

Type the subject and a message to send.

7

Click Send.
The Send Mail dialog box disappears and the e-mail is either
sent immediately or queued for background processing
depending on your Send Mail options.

Replying to a defect’s submitter
To send e-mail to the user or customer who submitted a
defect:
1

Select the defect you want to reply to from the Defects list
window.
You can also reply to a defect you are editing or viewing.
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2

Choose Reply to Submitter from the Mail menu.
The Reply to Submitter dialog box appears.

The recipient list is populated with the name of the user or
customer who submitted the defect report. The subject field
contains the defect’s summary text. The message body
contains defect’s description in quoted form.
3

Enter any additional comments to the body of the message.

4

Click Send.
The Send Mail dialog box disappears and the e-mail is either
sent immediately or queued for background processing
depending on your Send Mail options.
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Pausing e-mail notifications
You can temporarily pause sending e-mail via SMTP. E-mail
is still queued to be sent later when sending e-mail is
resumed.
To pause sending e-mail via SMTP:
Choose Pause SMTP Mail from the Mail menu.
To resume sending e-mail via SMTP:
Choose Pause SMTP Mail from the Mail menu again.
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14

Working with E-mail Import

Contents
About e-mail import
Configuring e-mail import

Simplify and improve technical
support!
Today an e-mail address on the Internet is
required to provide decent technical support.
TestTrack solves the problem of importing
those support issues into your defect tracking
system and responding quickly to customers.
This chapter explains how to set up TestTrack
to monitor a POP3 e-mail account for
incoming bug reports.
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About e-mail import
A compelling feature of TestTrack is the ability to monitor a
POP3 e-mail account for defect reports. Basically this feature
allows you to set up an e-mail account (e.g.,
support@seapine.com) and import any e-mail sent to that
account into TestTrack. TestTrack can automatically reply to
the sender with an e-mail confirming the receipt of the
support issue. The reply message is fully configurable and is
optional.
Using TestTrack’s deferred defect numbering, defects
imported from the e-mail account won’t be numbered until
you have a chance to review them. See Chapter 4, “Working
with defects,” to learn about deferred defect numbering.

Configuring e-mail import
E-mail import requires you to set up a dedicated POP3 email account to receive support issues from your customers.
TestTrack can then monitor this e-mail account for incoming
defect reports. These defect reports are added to the defect
list and the customers that submit the reports are added to
the customer list.
To access the Options dialog box and complete the Import
Mail tab:
1

Choose Options from the Edit menu.
The Options dialog box appears.
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2

Click the Import Mail tab and select the e-mail options.

The following describes the options:
Enable importing
defects via
Internet e-mail

Click the check box if you want to enable importing bug
reports from a POP3 Internet e-mail account. Enter the
address of the POP3 host (server), the e-mail account name,
and the account’s password.

Look for new
defects every

Select the interval you want TestTrack to look for new email to import.

e-mail an
acknowledgment

Click the check box if you want TestTrack to e-mail an
acknowledgment to the person who submitted the defect
report.

3

Click OK.
Your new options take effect.

Tip

You should also review the e-mail message template
containing the message that is sent back to the e-mail’s
sender. See Chapter 13, “Working with E-mail
Notifications,” to learn more about configuring e-mail
message templates.

Chapter 14. Working with E-mail Import
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Appendix A
Field Codes

About Field Codes
E-mail templates support fields codes. Field codes are
sequences of letters enclosed in percent signs that TestTrack
replaces with information from the project file. For example,
the sequence %DATS% is replaced with the current date in
mm/dd/yy format, while the sequence %DNUM% is
replaced with a defect number. .
Each e-mail notification corresponds to a single defect. You
use field codes to build personalized e-mail messages that
provide information specific to the defect that triggered the
notification or, in the case of an e-mail acknowledgment, was
imported via e-mail.

Appendix A. Field Codes

231

Field Codes
The following field codes are supported by TestTrack 1.6:
%ASSD%

The date the defect was most recently assigned.

%ASST%

The user to which the defect is assigned.

%COMP%
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The component containing the defect.

%DATL%

The current date in long date format (mmmm, dd yyyy).

%DATS%

The current date in short date format (mm/dd/yy).

%DESC%

The first defect description.

%DNUM%

The defect’s number.

%DOCA%

Whether the most recent defect fix affects documentation.

%DUPL%

The defect’s duplicate status.

%ENTB%

The user who entered the defect.

%ENTD%

The date the defect was entered.

%ESTB%

The user who most recently estimated the defect fix.

%ESTD%

The date of the most recent defect estimate.

%ESTE%

The most recent estimated effort to fix the defect.

%ESTW%

The defect’s most recent estimated fix date.

%FIXB%

The user who most recently fixed the defect.

%FIXD%

The date the defect was most recently fixed.

%FIXN%

The most recent notes about fixing the defect.

%FIXT%

The total time required to fix the defect.

%FIXV%

The version in which the defect was fixed.
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Field Codes (continued)
%FNDB%

The person who found the defect.

%FNDD%

The date the defect was found.

%FNDV%

The version in which the defect was found.

%MODD%

The date the defect was last modified.

%NUMR%

The number of users and customers reporting the defect.

%PRIO%

The defect’s priority.

%PROD%

The product containing the defect.

%REFR%

The defect’s reference field.

%RELH%

Whether the defect has release notes.

%RELN%

The defect’s most recent release notes.

%RELV%

The version in which the defect fix was released.

%REPR%

The defect’s reproducible status.

%RESO%

The defect’ resolution.

%SEVR%

The defect’s severity.

%STAT%

The defect’s status.

%STEP%

The steps to reproduce the defect.

%SUMM%

The defect’s summary.

%TCFG%

The defect’s test configuration name.

%TPLA%

Whether the most recent defect fix affects the test plan.

%TYPE%

The defect’s type.

%VERB%

The user who most recently verified the defect.
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Field Codes (continued)
%VERD%

The date the defect resolution was most recently verified.

%WORK%

The defect’s workaround.

%WRKH%

Whether the defect has a workaround.

Field Code Notes
Some addition information about field codes:
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•

All dates use the system defined date formats and are
year 2000 compliant. Unless otherwise specified, the
dates are represented in short date format (mm/dd/yy).

•

To include a percent sign (%) in the body of a message,
include two percent signs in a row (e.g., “%%”).

•

E-mail notifications support field codes in the e-mail
subject line. Therefore, you can include personalized
subjects such as “Re: %SUMM%” which expand to
include the defect’s summary field in the e-mail’s
subject.
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